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1 DCS Information 
The Defense Collaboration Services (DCS) is being developed as the follow on DoD 
collaboration capability. DCS will enable secure communications and collaboration by 
providing two distinct services with PKI authentication -- the ability for a stand-alone 
chat service based on the XMPP protocol with associated chat server and an in-browser 
web conferencing service. The web conferencing service includes a number of 
associated functions such as audio, webcam, white boarding, presentation sharing, 
desktop sharing, polling, recording, and a multi-user chat room.  
 
To begin using DCS: 
 
1. Go to https://www.dcs.apps.mil 
https://disa.deps.mil/disa/org/ES7/DCS/SitePages/Home.aspx  
2. This User Guide can be found at ( DCS User Guide ). 
3. Review training material as necessary located in the navigation column on the 
left for more detailed instructions. 
4. Enter the DCS service using the button labeled "Continue to DCS" on the upper 
left of part of the navigation bar.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1 DCS Information Portal: DCS Entrance 
 
 
 
 
 
 

Please Contact the Service Desk if an error, malfunction, failure to function, or operation 
issue occurs.   If you have any questions regarding DCS, please contact the DCS Service Desk 
(disa.dscc.eis.mbx.dcs-support@mail.mil) or call 614-692-0032 (Country code 001) or DSN 
850-0032 (DSN Country code 312). 
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2 Registration and Accounts 

2.1 Register and Use 

DCS will be available to all users contained within the Defense Manpower Data Center 
(DMDC) database that maintain a Common Access Card (CAC) in the Unclassified 
environment and PKI hard-token in the Classified environment.  This allows users to 
communicate and share information in a secure forum. DCS is able to provide the ability 
to connect coalition forces for collaboration purposes through guest access to meetings.  
 
DCS web conferencing and XMPP chat does not require registration or sponsored 
accounts. If you have a valid CAC or other PIV signature hard token you will 
automatically have access to DCS.  Note: There is no Username and Password 
associated with DCS.  Users that currently maintain dual personas or have in the past 
will require the activation and selection of their PIV certificate on the CAC. 
 
No information, data, scheduling, meetings, files, or recordings will transfer from DCO 
upon sunset of the service.  All chatrooms, groups, and settings contained within users 
DCO momentum Jabber client will not transfer to DCS.   
 
DCS is designed for individual Meetings of 250 personnel or less.  For conferencing that 
require more than 250 participants please review other enterprise of local offerings that 
are targeted to meeting requirements. 
 

2.2 DCS Security Configuration 

The DCS team reminds Users that all meeting hosts are responsible for verifying the 
identities of their meeting attendees.  Auto-promoting all attendees to Moderator is 
highly discouraged.  Attendees who have entered the meeting without authenticating 
will have "(guest)" appended to their name. 
 
Meeting Hosts are responsible for the moderating of sensitive material provided or 
displayed within the meeting.  Any breach or spillage should be reported properly. 
 
At this time the Defense Collaboration Services (DCS) system is not approved for 
transmission of PII and PHI information as identified in NIST SP 800-53, DoD 5400.11-
R Department of Defense Privacy Program and DoD 6025.18-R DoD Health Information 
Privacy Regulation.  For further reference please review these documents along with 
the Privacy Act and Health Insurance Portability and Accountability Act Core training 
document created by TRICARE. 
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2.3 DCS Public Key Integration  

DCS uses the email signature certificate from a User’s CAC for authentication purposes 
on the Information Portal, Home Page, and Meeting window.  This will work for all Users 
who have never maintained “Dual Persona” status with DMDC.  Those Users who have 
at any point ever maintained “Dual Persona” status will need to use the PIV certificate 
for authentication into DCS and the DEPS Information Portal.   

2.3.1 PIV Certificate Activation Steps 

In order to access DCS, DOD Enterprise Portal Service (DEPS) and/or Enterprise Email 
(EE), you will need to activate your PIV certificate if you are (or were) ever a dual 
persona user. The web site to do so is https://www.dmdc.osd.mil/self_service. 
 
To use functions within RAPIDS Self Service to update your CAC you must have the 
following installed on your computer:  
 
ActivClient (32-bit), JRE (32-bit) and a 32-bit browser (such as Internet Explorer 32-bit)  
Or  
ActivClient (64-bit), JRE (64-bit) and a 64-bit browser (such as Internet Explorer 64-bit) 
 
 Step 1 - After entering the link in your browser you should see the RAPIDS Self 
Service Portal (Figure 2). 
 

 
Figure 2 RAPIDS page 

 
 Step 2 - Click ‘Sign On’. And you will be taken to the “Self Service Consent to Monitor” 
page (Figure 3).  Select “OK”.   
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Figure 3 DEERS page 

 
Step 3 – From the CAC Login page (Figure 4) select “Login”. 
 

 
Figure 4 CAC login 

 
Step 4 - Select your email certificate and you will be taken to the RAPIDS Self Service 
Screen Figure 5). Click on ‘Activate PIV’ and follow the instructions. Once complete, you 
should be done with the RAPIDS web site. 
 

 
Figure 5 RAPIDS Self Service 
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Step 5 - Next click on the Microsoft start button, go to the ActivIdentity folder, then the 
ActivClient Folder and click on ‘User Console’ (Figure 6). 
 

 
Figure 6 Local ActivClient 

 
Step 6 – Double click on my certificates. Click on views and select list (Figure 7).  You 
should now see a PIV Authentication Key certificate in your certificate list. If not, step 5 
did not complete successfully. 

 
 

Figure 7 Locate Local Certificates 
 
Step 7 – Go to Tools -> Advanced and select ‘Forget state on all cards’ (Figure 8). 
Remove and reinsert the smart card in the smart card reader. 
 

  
DCS_User_Guide_20150126 13  

UNCLASSIFIED // FOUO 
 



DCS User Guide 
March 6, 2015 

 

 
Figure 8 Reset Certificates 

 
Step 8 – Go to Tools -> Advanced and select ‘Make Certificates Available to Windows’ 
(Figure 9). 
 

 
Figure 9 Identify New Certificates 

 
Step 9 – You should get a confirmation message similar to Figure 10. 

 
Figure 10 Confirm Certificates 
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Step 10 - Your PIV certificate should now be available to you when you attempt to log 
into DEPS; you MUST select the PIV certificate in order to gain access.  
However, which certificate is the PIV certificate is not obvious. For each certificate in 
your list, click on the ‘Click here to view certificate properties’ link.  
Go to the ‘Certification Path’ tab (Figure 11) and scroll all the way to the right. Continue 
with each certificate in the list until you find the PIV certificate. 
 

 
Figure 11 Identifying Correct Certificate 

 
 

 
 
Step 11 – If your PIV is still not available after step 10, someone with administrator 
rights to the computer in question needs to open Active Client ‘Advanced Configuration 
Manager’ (Figure 12). 
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Figure 12 Troubleshooting 

 
Step 12 – Select ‘Smartcard’ from the list. 
 

 
Figure 13 Identify Smartcard 

 
Step 13 – From the Smart Card Window below select ‘Prefer GSC-IS over PIV 
EndPoint’ and change the value to no. Click ‘Apply’ and then ‘OK’. 
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Figure 14 Set Correct Certificate Endpoint 

 
Step 14 – Reboot the computer. The computer should then begin to recognize the PIV 
Certificate.  
 
If you are an end user and you are still experiencing problems you will need to contact 
your level 1 service desk representative. If you call DISA Mechanicsburg level 2 service 
desk directly we will direct you to your level 1 service desk. 
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3 DCS Sections 
Navigation through DCS will be within four areas and referred to as the DCS Information 
Portal, DCS Home Page, DCS Meeting, and DCS Chat Client.  Below are descriptions 
of each of the DCS interactive environments. 
 
DCS Information Portal:  The DCS Information Portal page contains the information 
needed to understand and operate the DCS service on NIPR/SIPR with the ability to 
selectively submit feedback to the program through interaction with the product service 
desk.  Announcements posted by the DCS PMO regarding system availability will be 
posted along with training events and pertinent information regarding any future events 
for the DCS service.  Please refer to 3.1 for further detailed information. 
 
DCS Home Page:  The DCS Home Page provides the user a platform for reservation 
creation after being authenticated through the use of their CAC or other PIV signature 
hard token if user is maintains dual persona accounts.  Users will be able to create and 
administer reservations and invitations to scheduled Meetings.  Users will be able to 
access their recorded Meetings however will not be able to load or store files for use in 
Meetings.  Please refer to 3.2 for further detailed information. 
 
DCS Meeting:  The DCS Meeting window comprises up to 6 different panels: Display, 
Chat, Web Cam, Poll, Screen Share and User.  Within the DCS Meeting window the 
user will be able to interact with the presentation and other users at various permission 
levels.  The Meeting is where a user with proper permissions may be able to upload 
documents for use in presenting and whiteboard use.  Audio and web cam integration is 
supported and can allow the user to interact with others at Moderator, Presenter, User, 
and Guest permission levels.   
 
DCS Chat Client:  DCS allows for connection to a chat server through the Extensible 
Messaging and Presence Protocol (XMPP) by a PKI enabled chat client that accepts 
credentials associated with the CAC.  DISA provides an approved version with 
associated documentation for distribution; however, users may use any platform in 
which they are able to install.   

3.1 DCS Information Portal 

3.1.1 Portal Access and Design 

To access DCS, close all previously opened browser Windows.  Using a browser that 
supports access to the DISA Defense Enterprise Portal Service, access the URL:  
https://dcs.apps.mil.  
 
Please refer to the User System Requirements document to identify web browser and other 
support application version requirements. 
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Figure 15 DCS Information Portal Page 
 

3.1.2 DCS Portal Buttons / Sections 

The main sections of the DCS Home Page (Figure 15) are as follows:  Disclaimer, 
Announcements, DCS Information, Access to DCS, Calendar, Training Information, 
XMPP Chat Information, Request Addition to Email List, Survey and FAQ information. 
 
Disclaimer:  Provides users the information needed to make decisions based on the 
provided service and their current needs through the sunset period of DCO.  This 
disclaimer may change and be updated with no prior notification.  Any changes made to 
the system will be provided to the user community in accordance with DISA information 
release policies.  Located at the bottom center of the Portal site, the red color font 
indicates the need to be reviewed prior to initial use of the DCS service 
 
Announcements:  Within this section located in the top center of the DCS Portal page 
is information concerning day to day operations and information that is pertinent to 
users for conferencing abilities.  Information regarding current operating status, updates 
to services, or other general information for distribution may be found here. 
 
DCS Information:  This consists of information that may be pertinent to the user 
located on the Information Portal home page.  The information posted in the sections 
below the Disclaimer and Announcements locations provides targeted user information 
to assist with the operation of DCS. 
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Continue to DCS:  This button, located on the left hand side of the tool bar,    directs 
users towards the DCS Home Page.  Once selected, the user will be prompted with the 
DoD IT warning and acceptance, along with the authentication prompt to verify users 
and their ability to use service. 
 
DCS Training Calendar:  At this location a user is able to view upcoming training 
events and informational provisions that will be provided by the PMO to assist with 
transitions to DCS. 
 
Information  and Training:  The Information and Training section provides the user 
with a variety of documents and training manuals that are to assist user questions on 
operations or abilities of the service.  Please review documents prior to initial use.  
Training videos are provided in different formats for users viewing ability.  If a format is 
not present and would be helpful please contact the DCS service desk for the request. 
 
Frequently Asked Questions (FAQ):  Commonly asked questions and process are 
located at this site.  This is to be referenced when questions arising from operations or 
difficulties in completing tasks are present. 
 
Receive Email Updates:  This button and link directs users to a site where the ability to 
input email information for future correspondence is available. 
 
Getting Started:  This button and link directs the users to a site where high level step 
are provided to help the user get started with DCS. 

3.2 DCS Home Page 

The DCS Home Page provides general information and access to the configuration and 
setup portions of the DCS web conferencing abilities.  There are no locations to store or 
distribute files or documents to personnel.   

3.2.1 Entrance and Access 

To access the DCS Home page and the ability to schedule and create meetings the 
user must authenticate and agree to the DoD IT warning statement.  Select the 
“Continue to DCS” button on the DCS Information Portal toolbar.   
 
When prompted for authentication, select your valid DoD E-mail certificate.  You will 
now be taken to the DoD IT Warning Statement page (see Figure 16).  Read the terms 
of use and select accept to continue.  
 

Users that maintain Dual Persona credentials, which can be indicated by 
maintaining multiple CACs, being in two different categories of 
government service including a contractor and member of the National 
Guard along with users who have previously maintained Dual Persona 
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credentials will have to enable the PIV certificate on their CAC.  Please 
review the Dual Persona Login document for further information.  Once 
enabled the directions for use are the same as below but using selection 
of the PIV certificate INSTEAD of the CAC email certificate. 

 
Guest users attempting to enter the DCS system without the ability to authenticate via 
CAC or PIV signature will be taken to an error page due to the lack of ability for 
authentication.  Guest users when supplied with a meeting URL by an authenticated 
user will have the ability to join the meeting but no ability to schedule their own 
meetings.   
 
 

 
Figure 16 DoD IT Warning Page 

 
Your account is created automatically upon initial login.  Information will automatically 
update in the profile on a delay from DMDC with no need to manually perform changes 
in DCS when status changes.  Your information is taken from your CAC (Name, E-mail, 
and Organization) and from that stored by the Defense Manpower Data Center 
(DMDC), and will show up in your DCS Home Page.  Account information and 
previous activities on Defense Connect Online (DCO) will not transfer to DCS. 
 
Information for DCS profile and authentication is propagated from DMDC through use of 
IdSS.  Information trickles down from the DMDC authoritative source and renews every 
8 hours.  Any changes made to the DMDC database will show up in DCS within 1 day. 
 
The DCS Home page provides an overview of your DCS Meeting reservations and 
activities.  In it you are able to access your profile page and your account page.  From 
the DCS Home page, you are able to create new reservations and view reservations 
you have previously created or may be invited to.  The actions and abilities of the 
Reservation function are discussed in Section 3.2.4. 
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Figure 17 DCS “My Home” Page 

 
The Home page has three different sections: Navigation, Profile, and Reservations.  
These sections consist of horizontal banners with the color transitions on the Home 
Page as displayed in Figure 17.  The Navigation section persists on all pages and 
provides the ability to return to the home pages and logout of the DCS service.  The 
Profile banner provides the account information to verify that the user is in the correct 
account and navigation to the “Profile” and “Accounts” pages.  The Reservation section 
displays all the reservations that the user maintains permissions in along with the button 
to create new reservations. 

3.2.2 Profile Page 

The Profile page (See Figure 18) provides general information about the user (Name as 
it appears on their CAC, E-mail, and organization).  It also provides a summary of your 
recent activity in DCS.  Users are unable to change or edit information or images 
contained within the profile page.  All edits to user information contained on this page 
must be made through the Defense Manpower Data Center (DMDC) milConnect portal.  
The portal can be found at: https://www.dmdc.osd.mil/milconnect. 
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Figure 18 User Profile Page 

 
Access to the milConnect portal can also be gained through the “Edit Profile” link below 
the shadow image on the right hand side.  The “Recent activity” and “Reservation” tabs 
located in the upper right corner provide a list of meetings that the user has participated 
in recently in two different formats. 
Links found in the DCS banner are common across both the “Profile” and “Account” 
pages.  The “My Home” link allows the user to return to the DCS Home Page.  The drop 
down menu with the user name located over it provides a secondary method of access 
the “Profile” and “Account” page along with the ability to logout. 

3.2.3 Account Page 

The Account page, access found through the link in the DCS banner on the “My Home 
Page” or through the dropdown menu provided on the “Profile” page, provides users 
with information about their account (E-mail, User ID, Time zone).   
 
Users are unable to change or edit information or images contained within the 
Account page other than time-zone.  The information on this page can only be seen 
by the User.  Adjusting the “Preferences” time zone drop down menu does not alter any 
other aspect of the DCS tool. 
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Figure 19 DCS Accounts Page 

 
Links found in the DCS banner are common across both the “Profile” and “Account” 
pages.  The “My Home” link allows the user to return to the DCS Home Page.  The drop 
down menu with the user name located over it provides a secondary method of access 
the “Profile” and “Account” page along with the ability to logout. 

3.2.4 Reservations 

Reservations are the visual placeholders that provide information regarding Meetings.  
All meetings will require that the user creates a Reservation.  Within the reservation 
pages Users are able to find tabs and links allowing the User to grant permission levels 
to participants, copy and provide the URL that will direct users/guests to the Meeting, 
start/stop Meetings, identify if the Meeting is to be recorded, and include how many 
participating users are anticipated for the Meeting (max 250).   
 
No files can be stored in a reservation.  Reservations will persist after a meeting has 
ended until a user deletes the reservation.  If a User does not access a reservation for 
more than 180 days the reservation will be removed by the system and anything 
associated with the reservation will not function correctly.  Permissions for other users 
may be granted for the reservation, but must be completed on a 1-by-1 process 
documented in Section 3.2.6.4. 
 
Administrator: The Administrator has the highest level of permission over the web 
reservation.  All Administrators have equivalent permissions with no one maintaining 
higher preference.  An Administrator is able to change permissions of all users including 
themselves (Note: if no user has Administrator permissions there is no way to delete the 
reservation and this cannot be performed by the Service Desk or Tiered support 
administrators).  The administrator maintains and controls the overall operation of the 
web reservation through the extra “Admin” tab within the reservation space. 
 
Moderator: The Moderator permission level differs from the Admin in the Reservation 
only.  The inclusion of the user to the reservation will place a reservation placeholder 
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with the Moderator’s home page allowing for the ability to reference the meeting at a 
later time.   

3.2.5 Create a Reservation 

To create a reservation, go to the Home page by clicking “My Home”; click the “Create a 
new reservation” button on the right hand side of the screen.  This step will take you to a 
new page where you will need to provide a Reservation name and description, both 
fields are required.  When this is complete click “create”, you will be taken to your 
reservation’s home page, Figure 22.  
 

 
Figure 20 Create New Reservation Button 

 
A name must be provided to the requested field to give the reservation an identifying 
attribute for yourself and other users to identify.  The information provided by users in 
this field will not be used in the meeting URL or as identifying features to guest users.  
Users are unable to customize meeting URLs in DCS.  
 

 
Figure 21 Define New Reservation 

 
The Description field requires the User to provide information that would like to be 
shared with other users granted access to this reservation.  Once both fields are 
populated click on the “Create” button. 
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3.2.6 Reservation Home 

The Reservations home page provides an overview of the created reservation (name of 
reservation, reservation description, users that recently joined) along with the abilities 
for reservation administrators, those granted admin permissions, to make edits to the 
reservation.   

 

 
Figure 22 Reservation Home Page 

 
Users that do not poses Admin permissions will view a page with different information 
and abilities than those as displayed in Figure 22 as seen in Figure 23. 
 

 
Figure 23 Non-Admin Reservation Page 
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3.2.6.1 Tab-Web Conference 

The “Web Conference” tab (Figure 24) provides information on current run status of the 
web reservation.  The Meeting URL, used to invite other DCS Users to your meetings, is 
displayed in the center of the page.   
 
To invite another registered User or Guest User, copy and paste the URL into the 
method of communication being used to provide the meeting invitation message.  DCS 
is not configurable to interact with other applications for scheduling interactions or 
applications.   

 

 
Figure 24 Web Conference Access Tab 

 

3.2.6.2 Tab-Recordings 

• DCS provides recording and playback capabilities for web conferences.  If 
meetings associated with the reservation have been recorded they will appear on 
the Recordings Tab (Figure 25).  The recordings are saved in an MP4 format, 
and are available for 180 days from creation.  Ensure you download your 
recordings to your computer once they are created.   
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Figure 25 Recordings Tab 

 
To download a recording, select the “Download” link as shown in Figure 26. 
 

 
Figure 26 Recording Download 
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Once you have selected download, a pop up will appear asking if you want to save or 
open the recording (Figure 27).  If you select “save” DCS will save it to your Downloads 
Folder.  If you select Open, DCS will open the recording in QuikTime Player.   

 
Figure 27 Open or Save Recording 

3.2.6.3 Tab-People 

The “People” tab (Figure 28) provides the User with information of all Users 
(Administrators or Moderators) associated with the Reservation.  The integrated 
information provides insight on who is currently in the reservation along with Users 
identified as administrators.  This is not the correct tab to add users to reservation. 
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Figure 28 Meeting People Tab 

3.2.6.4 Tab-Admin 

The “Admin” tab provides the ability to configure the reservation, the ability to change 
the name or description (Figure 29), and the ability to add users to the Reservation.  
The inner tabs in the Admin section provide the ability to include Administrators or 
Moderators in the reservation space (Figure 30), and promote users privileges (Figure 
32).  The ability to delete or remove Reservations is available under the General 
Options sub tab in the Admin section.  The button located on the bottom and highlighted 
in red allows an Administrator of the Reservation the ability to remove the Reservation.  
Once the Reservation is removed all permissions and recordings associated with the 
Reservation are lost and unrecoverable. 
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Figure 29  Meeting Admin Tab 

 
 
Permissions can be assigned to Users by the reservation creator.  It is recommended 
that at least two Users maintain Admin permissions for a reservation.  Users may be 
searched under the admissions sub-tab in the Admin tab.  When adding users to the 
reservation the Admin must type out the full email address of the user to perform the 
search.  If the full address is not used this may produce an error and the inability for the 
Admin to find the user.   
 

Tip:  When searching for Users, copy and paste the intended users email 
address from an email client.  If unable to find the correct User or if presented 
with an error using the correct email address please contact the service desk for 
assistance. 
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Figure 30 Add User to Reservation 

 
Once the Admin has searched and located the intended User, the Admin is able to 
assign permissions to the User as identified in (see Figure 31).  The Admin is able to 
provide the User with Admin or Moderator permissions allowing the User to have 
increased abilities and actions on the Reservation and in the Meeting.  
 

 
Figure 31 User Permission Options 
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Figure 32 Meeting User Privileges  

 

3.3 Meetings 

A Meeting can only be started by an administrator of the reservation.  The Meeting is 
where users are able to collaborate and communicate.   

Users need a web browser capable of running Flash 11.2. To check the version of flash, 
visit Adobe's Flash Version Check page.  As of Mac OS X 10.6, Apple stopped updating 
Flash. If a Mac user is running an out-of-date version of Flash they can upgrade by 
visiting the get Flash player page at Adobe. 

To run the desktop sharing, the presenter (and only the presenter) needs to have a 
Java runtime. You can test that Java is installed by visiting Java Test Page (there are 
download links on this page if you need to install Java).  Users may be required to 
coordinate with their system administrators to ensure that the correct versions and 
settings are available for their use.  DCS is distributed with publically signed certificates 
that allow all users with at least Adobe v7u46 the ability to Desktop Share.   

For bandwidth, we recommend 1Mbits download and 0.5 Mbits upload speed. Users 
can test their actual bandwidth using speedtest.net. 

For hardware, it is recommend a Dual-core CPU with at least 2G of memory. For Mac, it 
is recommend any Mac running Mac OS X operating system. 
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3.3.1 Meeting Permissions 

Moderator: The Moderator has the highest level of permission over the Meeting. The 
moderator may control a User’s presence, audio status, chat ability, and presenting 
permissions within the Meeting and can only be overridden by another Moderator.  
Moderators in a meeting are responsible for information displayed and Users 
admitted.  Dependent on meeting clearance level and requirements it is the 
Moderator to proctor attendees and displayed documents. 
 
Presenter:  The Presenter permission is only available within the meeting.  The 
Presenter permission cannot be granted within the Reservation space.  The permission 
persists only for the current meeting.  If the meeting is restarted, a Moderator must re-
assign the permission to the User.  The selected Presenter will maintain the 
permissions as long as they stay Presenter.  The Presenter may control and navigate 
the Presentation panel along with basic abilities in the User panel.  The Presenter may 
upload and display files.  There is only one presenter at any given time.  The view of the 
Presentation panel and buttons available in the top left tool bar will differ from all other 
users.  Guest Users may be granted permission by any Moderator. 
 
User:  Users enter the meeting with no capabilities or control functions as those 
identified be part of the Moderator or Presenter permission capabilities.  The benefit of 
entering as an authenticated user is it allows the Moderator the ability to verify the 
Users identity.  The User permission level is able to participate in the Chat panel, in 
both public and private chat.  The User may download screen shots of the Presentation 
panel for reference.  The User permission level is allowed to “Raise a hand” in the User 
panel, however most other features are limited and not available for use. 
 
Guest User:  Guest Users are those that are unable to authenticate as verified Users.  
Access to meetings is based upon the validation of a Moderator upon request for 
entrance.  Guest Users are able to enter and participate at the same level as a User in a 
meeting.  Guest Users are not able to create or use Reservations.  Guest Users are 
able to be granted the permission of Presenter in a meeting. 

3.3.2 How to Begin a Meeting 

Meetings can be entered in two separate ways.  Based on permission level a User may 
only be able to enter a Meeting or have full permissions to begin one.  It is advised that 
reservation Admin’s provide at least two Users’ with Moderator or Admin 
permission levels for each reservation.  This assists with the ease of starting 
meetings and coordinating efforts during the meetings. 

3.3.2.1 Administrator/Moderator 

Administrators and Moderators are able to start Meetings.  All other entering users must 
wait until an Admin or Moderator begins the meeting and begins to accept users into the 
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meeting.  To begin a Meeting the Admin/Moderator should select the “Start” button 
(Figure 33) in the Reservation panel provided after selecting the correct reservation 
from the DCS Home Page.  

 
 

Figure 33 Meeting Start Button 
 
Both the selection of the “Start” button and the “Preference” button will display a pop-up 
screen that allows the Admin/Moderator to select options for the Meeting.  There is an 
option to fast start a Meeting.  The separate button on the right hand side of the “Start” 
button will immediately start a Meeting with any predetermined preferences stored in the 
system.  All options that are selected are persistent within the Reservation until change 
or removal of the Reservation (Figure 34). 

 
Figure 34 Meeting Preference Options Selection 
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Record Meeting: Meetings can be recorded in 60 minute increments.  To allow for the 
ability to record a meeting this check box must be selected.  Recording will be controlled 
by a Moderator in the Meeting window and be available to all Users associated with the 
Reservation in the “Recording” tab.  Recordings are available in .MP4 format. 
Audio: The audio function feature will allow the Admin/Moderator who starts the 
Meeting to determine if there will be in meeting audio allowed.  If this check box is not 
selected the Meeting will load without the ability to participate in audio interactions. 
Currently the system does not begin to observe functionality degradation until more than 
80 open audio channels are present on an individual conference server.  If observing in 
Meeting audio issues please contact the Service Desk for assistance. 
Number of Participants:  DCS is designed to be used for up to 250 users per 
individual Meeting and 10,000 overall concurrent Users in Meetings.  Identifying the 
number of intended users allows DCS to situate the Meeting for optimal operation.  The 
number of participants listed in this box is not a limit on the actual Meeting, however the 
closer the number to actual participants the higher likelihood of optimal performance 
within the meeting.   

3.3.2.2 User/Guest User 

Presenters, Users, and Guest Users are unable to start a meeting.  Users at these 
permission levels may only join meetings. 

3.3.3 Joining a Meeting 

3.3.3.1 User 

In order to enter a meeting, as a User you must have been provided a URL from the 
Meeting Moderator or Administrator.  After accepting the US DoD IT warning statement 
you will be presented with a screen that identifies the status of the Meeting (Figure 35).  
The status indicator will automatically update on the screen to reflect the meeting. 

 
If the meeting is identified as currently running the User is able to join the meeting.  The 
User will be identified by their Public Display Name (PDN) that is also used in other 
enterprise applications.  The PDN is static and cannot be changed through DCS.   
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Figure 35 Meeting User Start Button 

 

3.3.3.2 Guest User 

A Guest User is an invited participant to a meeting that does not have a DCS account 
and is unable to authenticate identity through the use of a CAC or Hard Token 
depending on the network.  As an invited participant the guest user is unable to start a 
meeting and will be presented with a URL for access.  If arriving before an 
Admin/Moderator has started the Meeting, the Guest User will have to wait until the 
Meeting begins.   
 
Users experiencing authentication problems may be asked to enter as a Guest User.  If 
this occurs contact the service desk for assistance.  When entering if issues arise due to 
web browser or incorrect configuration settings please reference the “Web Browser 
Configuration” document located in the Information Portal. 
 
To access DCS as an invited Guest User review your e-mail for a supplied URL, and 
click on the link provided, you will be directed you to the Meeting entrance page.  The 
Guest User will be presented with the requirement for entering a name and organization 
for reference and identification.  This information will provide the Moderator for a choice 
on admittance for the Guest User to the Meeting.  Upon completion of the identification 
information the Guest User is presented with a “join now” (See Figure 36 and Figure 37 
below).  
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Figure 36 Guest User Identification 

 

 
Figure 37 Join Meeting Button 

3.3.4 Meeting Panels 

The meeting screen is broken into four different configurable and movable panels.  
Upon entering the meeting window a User will view the default configuration of meeting 
panels.  The meeting panels are the Display, Chat, User, and Web cam panels.  Only 
one instance of each panel is allowed at time, however there are no requirements for 
having all viewable at all times.  Each panel operates similar to a window, sizing can be 
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performed by clicking and holding a corner and dragging, to minimize, maximize or 
close each panel see the buttons in the upper right corner.   

 
Figure 38:  DCS Meeting Panels 

3.3.4.1 Presentation Panel 

The Presentation panel is initially situated in the center of the meeting window.  The 
Presentation panel will natively display an interactive slide that allows users to access 
documentation and information from the Meeting window without first accessing the 
Information Portal. 
The Presentation panel provides two different setting based on the user permission 
level. 
Moderator:  This is the permission level provided upon entrance by any 
Admin/Moderator from the associated reservation.  This permission can be granted by 
any moderator to a User in the meeting.  All moderators have full permissions (other 
than those of a Presenter) in the meeting and can “step” over each other’s actions.  
Care should be given to coordination of granting permissions in meetings. 
 
Presenter:  This permission level, which exists only in the meeting, allows for one user 
to be able to present material or manipulate the view of all other users in the 
Presentation panel.  Moderators are able to grant and remove the presenter permission 
in the meeting.  The may only be one presenter at a time.  The Presenter will have more 
buttons available within the presentation panel and top-left toolbar.  Only the presenter 
may upload files or share the view of their screen.   
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User:  This permission level can only view the Presentation panel during meetings.  The 
authenticated User is able to be granted the Presenter or Moderator permission levels 
by other meeting Moderators.  Once a Presenter, the User is able to interact with the 
Presentation panel for other Users to view. 
Guest User:  This permission level is for any un-authenticated users.  Guest Users only 
able to interact with the Presentation panel when made Presenter by a meeting 
Moderator.   

3.3.4.2 Document Manager 

The Presentation panel allows the Presenter to upload documents for presentation in 
the panel.  Documents that are accepted are Microsoft Word, Excel, PowerPoint, Adobe 
PDF, and JPEG images.  DCS will automatically convert Microsoft Word, Excel, and 
PowerPoint to PDF files. 
 
Users without permissions may download a screen shot of the current displayed image 
as a jpeg file.  DCS does not support the ability to download the file being 
presented. 
 
To download a screen shot of the current Presentation panel select the button on the 
left in Figure 39, found in the bottom center of the Meeting screen.  If you want to 
upload a document as a presenter, select the button on the right in Figure 39. 

 

 
Figure 39 Meeting Document Control Button Panel 

 
 

When, as a Presenter, the file upload button is selected a window as seen in Figure 40 
will appear.  Select the file you want to share and click upload. 
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Figure 40 Document Upload Control Window 

 

3.3.4.2.1 Display White Board Editing Toolbar 

The Presenter maintains the ability to edit and interact with a document in the 
Presentation panel.  The Presenter is provided with a side bar (as seen in Figure 41) 
that allows for the ability to write on the document, create shapes (square, circle, 
triangle, line), add text, undo, undo all, and change editing color.   
 
 

 
 

Figure 41  White Board Control 
Panel 
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3.3.4.3 User Panel 

 
All participants are able to view a User Panel (Figure 42) within the meeting.  The user 
panel presents a list of all users currently in the meeting along with their permission 
status (presenter or viewer), full Persona Display Name, and current media in use 
(microphone, web camera, etc).  The User panel does not record meeting 
attendance nor is there a way to automatically record meeting attendance within 
DCS. 
Moderators are provided with extra capabilities within the Use panel.  The additional 
permissions include being able to remove the participant from the meeting through the 
“kick” user option, promoting one time to moderator, lowering “raised hands”, 
enable/disable Presenter permissions, muting users, and locking features. 
 

 
Figure 42 User Panel 

 

3.3.4.3.1 User Panel – Toolbars 

The gear button, found in the low left of the User panel in Figure 42, allows the 
Moderator to lower all participant’s hands, mute all users, mute all users except the 
presenter, lock all users, lock users except presenter, and lock settings (see Figure 43).  
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There is no ability in this list to lower individual users hands, or unmute individual users 
after “Mute All Users” has been selected.   
 

 
Figure 43 Moderator options 

 
 
For a participant, it will enable a User to “Raise their hand”.  Users, unless locked by the 
Moderator are able to unmute their microphones after a “mute all” command has been 
made.  Users are able to identify what command has been made by the Moderator by 
observing the columns next to their name in the User panel. 
 

 
Figure 44 Setting Buttons 

 
The Red Stop sign, when selected by a User, will cause a logout action to occur.  When 
selected by a Moderator of the meeting this will end the meeting and logout all users. 
Prior to ending the meeting and not allowing any users to continue to work in the 
meeting space the Moderator will be prompted with a confirmation screen (Figure 45). 
 

 
 

Figure 45 End Meeting Option 

3.3.4.4 Chat Panel 

The chat panel (see Figure 46) allows participants to conduct in meeting chat 
conversations with both the public group and with private user-to-user capabilities.  The 
“Public” Tab shown in Figure 46 displays the Public facing chat abilities of DCS.     
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Figure 46 Chat Panel 

 
The “Options” tab (Figure 47) allows for Users to engage in private chats with other 
users present in the meeting.  Follow the instructions and select an available user to 
begin a chat with.   
When a response is received from the User the tab will flash yellow indicating that a 
new message is available for viewing.  The Options tab also allows for the User to 
change the size of the font in the chat panels to allow for easier viewing of messages. 

 
Figure 47 Chat Panel Options 
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Chat conversations can be migrated from the chat panel in the meeting window to a 
different source.  This is provided through a copy and paste process (Figure 48).  The 
participant must: 

• Highlight a word in the chat panel. 

• Left click the mouse button. 

• Select the “Copy all text” option. 

• The user can then past the text to a word document or notepad file. 
 

 
Figure 48 Chat Panel Copy Messages 

 

3.3.5 Meeting Operations and Functions 

Upon being accepted and entering the meeting the user, regardless of permission level, 
will be requested to finalize needed configuration options.  The meeting tool is based on 
Adobe Flash Player and requires that the user allow access to local storage for the 
settings.  Select allow on the Adobe Flash Player local storage request window (Figure 
49).  You should now be able to see the Meetings page as in Figure 50. 
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Figure 49 Flash Player Option Window 

 
 

 

 
Figure 50 Meeting Page 

 

3.3.5.1 Meeting Operations Toolbar 

DCS allows you to enable or disable Meetings features, as shown in Figure 51.  Click 
on the headphones to enable audio, click on the webcam to share webcam, click on the 
screen to share desktop, click the chart to enable polling.   
 

 
Figure 51 Operations Tool Panel 

 

3.3.5.1.1 Microphone / Headset  
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Clicking on the headphones icon in the upper left (“Join Audio”) will cause a prompt to 
be presented (Figure 52).   

 
Figure 52 Adobe Flash Player Settings Acceptance 

 
 

Select “Allow” on the Adobe Flash Player Settings window.  When presented with the 
window to configure audio and webcam select “Test or Change Microphone” to test and 
verify your microphone and select “Test Speakers” to verify your speakers (Figure 53).  
 

 
 

Figure 53 Audio Setting Panel 
 

 
Figure 54 Microphone Setup 

 
The Microphone configuration panel (Figure 54) will appear allowing for the options of 
changing the microphone option to connect to a local microphone or input device.  If you 
are unable to connect or identify your microphone please consult your system manual 
or contact your local system analyst to resolve. 
 
After selecting your microphone or audio input device a user is able to test the speakers 
associated with the system by selecting the button labeled “Test Speakers”.  Once the 
button is depressed sound will be played from any connected speakers.  To end the 
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test, select the button once more.  To complete the workflow, select the “Join Audio” 
button and return to the meeting panel. 
 
Control of the local microphone of headset during the meeting can be performed in two 
different manners.  If there is a local push-to-talk feature on the hardware this may be 
used to assist in speaker control.  The use of the “Mute” (Figure 55) button in the tool 
bar may also be used.  The Mute button will appear after the microphone has been 
connected and can be selected or un-selected to control your audio during a meeting. 
 

 
Figure 55 Input Toolbar (Mute Button) 

3.3.5.1.2 Web Camera 

Within the tool panel exists the option to connect and control a webcam for meeting 
participation (Figure 56).  This can be performed by selecting the second button in the 
tool panel, one that is in the image of a circular webcam.   
 

 
Figure 56 Input Toolbar (Web Camera) 

 
The Webcam Settings box will open up and will identify if the ability for a web camera is 
present or not, (Figure 57), along with ability to configure settings and to start sharing 
with other participants.   
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Figure 57 Web Camera Settings 

 
To configure the setting of the Webcam the “Change Webcam Settings” (Figure 57and 
resolution settings buttons may be used.  To identify a new input source select the 
“Change Webcam Settings” button and proceed in using the new pop-up panel (Figure 
58) to identify a Webcam input source. 
 

 
Figure 58 Webcam Input Selection 

 
The resolution selection feature allows the ability to select how fine a resolution to 
provide and display.  This will assist when attempting to resize the webcam panel within 
the meeting window.  A lower resolution selected will allow for greater performance but 
only provide clarity in a smaller space, while the opposite is true for greater resolution 
selection.  To close the webcam within in the meeting space the webcam button within 
the toolbar must be selected again. 
 

3.3.5.1.3 Desktop Screen Share 

Screen sharing is available within DCS.  The Screen sharing feature allows the 
Presenter to share the entirety or a specified region of their screen.  The screen share 
ability is affected by two limiting factors: 

1) The Presenters local configuration allows for the use of Java v7u45 or greater 
within their web browser. 

2) The speed of all connected networks will determine the screen refresh rate.   
The screen share feature is available to one Presenter at a time.  Specific applications 
or application screens are not available for selection or control.  The feature shares all 
information that is present on the screen to include current resolution and color scheme. 
TIP:  It is recommended for best use that the lowest possible resolution is uses along 
with the smallest area of sharing.   
To begin screen sharing as the Presenter identify the operation button in the upper left 
toolbar as see in Figure 59. 
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Figure 59  Screen Sharing Button 

 
After selecting the screen share button a new panel will appear in the lower left corner.  
This panel will cover any panel that was previously in view.  This does not close the 
underlying panel and may be moved  

 
Figure 60 Screen Share Panel 

 
To load the DCS Screen Share feature the system of the Presenter must be loaded with 
Java v7u45 or greater and integrated with the web browser being used.  Local system 
administration policies regarding web browsers may cause usage issues.  When 
experiencing issues with Screen Sharing, please check with local system 
administrator prior to contacting DCS Service Desk.  
Selecting the “Full Screen” option will allow the Presenter to share the main screen in 
their current configuration. 
Selecting the “Region” option will allow the Presenter to share a defined region of any 
screen in their current configuration.  The region conforms to the main display and may 
not resize to a User defined screen. 
Once selecting the region of screen share, the local system will prompt the User for 
allowances (see Figure 61 and Figure 62) to continue with the use of the feature.  
Accept all prompts.  This will result in two different options depending on the initial 
selection. 
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Figure 61 Trusted Connection Prompt 

 
 

 
Figure 62 Browser Configuration 
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Figure 63 Java Run Confirmation 

 
When using the regional a red square will appear on the screen.  This square can be 
selected and moved to the region preferred.  In the middle is a button that states “Start 
Sharing”.  Once the correct region is identified, select the button (see Figure 64).  The 
red square will persist but will not be present to the Users. 
 

 
Figure 64 Regional Share Button 

 
In the bottom right of the local Windows system a notification will be present see (Figure 
65).  
 

 
Figure 65 Sharing Notification 

 
To close and end the screen sharing feature the Presenter will need to select the close 
button (see Figure 66) from the screen share panel. 
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Figure 66 Screen Share Close Button 

 
After the “Close” button is selected a “Security Warning” screen is presented.  Select 
“Allow” and continue with the presentation.   

 
Figure 67 Completed Screen Share 

 

3.3.5.1.4 Meeting Poll 

 
DCS provides the ability for meeting users with the Presenter permission to create and 
display a poll to users currently in the meeting. To create and display a poll, select the 
“Create New Poll” button (Figure 68) from the tool bar located in the upper left corner of 
the meeting window. 
 
 
 

 
Figure 68 Input Toolbar (Poll) 

 
A new poll setup panel will appear.  Size is set and may appear differently in different 
browsers.  To create a poll, the user must populate the Title, Question, and Answers 
fields to submit to the users (Figure 69). 
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Figure 69 Poll Setup 

 
Tip:  If unable to see the bottom buttons, maximize the panel. 
 
Once the fields are populated, the option to allow users to choose more than one 
response is available.  After completion of the form select the “Preview” button to move 
to the next step. 

 
Figure 70 Poll Setup (Review and Publish) 

 
Upon review of what the poll will look like to the users, the options to Modify, Publish, 
Save, or Cancel the poll are available to the Presenter.  The option to save the poll will 

  
DCS_User_Guide_20150126 54  

UNCLASSIFIED // FOUO 
 



DCS User Guide 
March 6, 2015 

 
save the current fields and place as an option for quick selection in the Input Toolbar for 
later use (Figure 71). 
 

 
Figure 71 Save Poll 

 
Tip: Create all polls for the meeting prior to the start of the meeting to assist with flow 
and timing of meetings. 
 
Select the Publish button and broadcast the poll to all users that are currently present 
within the meeting.  Any user entering the meeting after the poll has been published will 
not be able to view or vote in the poll event.  The published poll will appear in the 
presenters screen and be a movable panel (see Figure 72). 
 

 
Figure 72 Published Poll 

 
 
To end the poll, select the “Stop Poll” button.  Provided in Figure 73 are the options 
available once the “Stop Poll” option is selected.  This provides the ability for the 
Presenter to “Repost” the Poll, “Share” the poll with the users within the meeting, or 
completely “Close” the poll. 
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Figure 73 Stop Poll 

 

3.3.5.2 Meeting Administrative Toolbar 

 
Located in the upper right corner of the meeting window, this tool panel provides higher 
level settings and information regarding the status of the meeting.  From this tool panel 
the user is able to set meeting entrance preferences, identify time left in meeting, and 
the ability to logout of the meeting. 

3.3.5.2.1 Administrative Toolbar – User/Guest Admittance 

This button is only available to Moderators or the meeting and will not be displayed in 
the user or guest user meeting windows.  The wrench in Figure 74 enables the 
administrator to configure how participants are allowed into the meeting.  This tool 
applies the selected operation to all users that join the meeting after selection.  To 
change the option the user must select another option. 
  

 

 
Figure 74 Configurations Panel: Access Permission Button 

 
The menu presents the options for the Moderator to set access permissions to users 
entering the meeting.  The options are: “Ask moderator”, “Accept all users”, “Accept 
authenticated users”, and “Deny everyone” (Figure 75).   
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Figure 75 Configurations Panel 

 

3.3.5.2.2 Administrative Toolbar – Meeting Timer 

The reset logout timer controls the ongoing timer for the meeting.  The time is initially 
set at 120 minutes (see Figure 76).  The timer will continue to count down unless the 
“Reset Logout Timer” button is activated or the user uses an associated microphone for 
communication in the meeting.  Upon conclusion of the timer the meeting will end for 
the user.  To continue the user will need to re-enter the meeting.     

 
Figure 76 Logout Timer 

3.3.5.2.3 Administrative Toolbar – Logout  

The “Logout Button” (Figure 77) will log you out of the Meeting. 
 

 
Figure 77 Logout Button 

3.3.5.2.4 Administrative Toolbar – Recording 

The Recording button on the administrative toolbar will enable and disable the recording 
of the meeting.   
 
 

 
 
The button will be present on the toolbar, if the option to record the meeting was 
selected (Figure 79) when you created or modified the reservation.   
 
  
 
 
 
 
 
When you are ready to start recording the meeting, click the start icon (Figure 80).   

Figure 78 Record Meeting Button 

Figure 79 Reservation Meeting Options 
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Figure 80 Start Recording 

3.3.5.3 Layout Manager Toolbar 

The Layout Manager Toolbar (Figure 81) allows the user to select and display different 
combinations of the 5 panels to assist in interaction with meetings.   
 

 
Figure 81 Meeting Layout Panel 

 
The toolbar is located in the bottom right of the meeting window.  The drop down menu 
(Figure 82) allows you to choose a visual layout of different assortments of panels for 
your Meeting.  

 
Figure 82 Custom Layout 

 
The first button from left to right allows the user to add the current layout contained 
within the meeting window.  Selecting this button will create an entry in the drop down 
menu for future use.  The toolbar allows a user to save these custom layouts.  To save 
a layout the user MUST add the layout to the drop down list prior to selecting the save 
button (Figure 83).  The save feature will save the drop down list and not the current 
layout. 

 
 

Figure 83 Save Layout Button 
 
To load a saved layout list the user selects the load button (Figure 84) and is presented 
with a screen to identify which file is to be uploaded to the meeting Layout Manager. 
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Figure 84 Load Layout Button 
 
When users initially enter a meeting all participants, regardless of permission levels, by 
default have the ability to manipulate their meeting widow panels how they would like.  
Users with the Moderator permission level all have the ability to lock a specific layout for 
users to be forced to view. 
 
The button on the far right of the tool bar represented by the “lock” image (Figure 85) 
grants any user with Moderator permissions of the meeting the ability to lock their 
current layout of meeting panels and push the layout to all Users participating in the 
meeting.   

 
 

Figure 85 Lock Layout Button 
 

 
All users have the ability to capture information about the meeting occurrences whether 
in a meeting or during the “connecting” phase of a meeting.  When contacting the 
Service Desk you may be requested to provide a “Log” of events that caused the issue.  
To do this after the log is opened, copy and paste the information to a Word document 
and save locally. 
 
The Log Button on the Layout Manager Toolbar (Figure 86) captures a log of all activity 
that has occurred up to the time the log button is pushed.  This information also 
contains information of user activity during the meeting. 
 

 
Figure 86 Log Button 

 
The information provided in the Log Window (Figure 87) can be copied and pasted into 
another document and provided to the Help Desk to assist in troubleshooting.  After the 
information is copy and pasted, the moderator is able to perform a “Find” event in Word 
to search for the word “Joined”.  This will allow the moderator to identify an attendance 
list if wanted. 
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Figure 87 Log Window 
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Page Break to identify material that still requires a review. 
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4 DCS Chat Client 
DCS provides an Extensible Messaging and Presence Protocol (XMPP) based instant 
messaging client.  The XMPP instant messaging client allows Users to create user 
groups and instant messaging ability to users through XMPP protocol with PKI 
authentication.  DISA has verified and provides the Air Force Research Labs (AFRL) 
TransVerse cross domain XMPP chat client as the DCS branded client.  Any client that 
complies with PKE and can be directed at the DCS chat server may be used, if allowed 
on your system. 

4.1 What is TransVerse? 

TransVerse serves as an XMPP client within the Chat system architecture. XMPP is an 
eXtensible Markup Language (XML)-based instant messaging, presence and multi-user 
text chat protocol. TransVerse is an open-standards-based product.  
 
TransVerse facilitates a virtual work community because its capabilities are similar to 
those found in physical office environments. For example, daily tools such as meeting 
places in HQs and individual meeting rooms are available within the TransVerse client 
environment. Some of the functions you can perform in TransVerse are listed below:  
 

• One-to-one Chat (same-domain only)  
• Group Chat  
• Hyper-Rooms  
• Tiling Options  
• Add and Manage Contacts (same-domain only)  

 
The DCS DISA branded version of TransVerse is maintained and hosted within the 
DCS Information Portal for download.  TransVerse is available for downloading at:  
 

NIPRNET:  https://extranet.if.afrl.af.mil/cg/software_tv.php 
SIPRNet:  https://rie.afmc.af.smil.mil/cg/software_tv.php 

 
Additional XMPP chat clients with PKI integration can be utilized for use on DCS. 
 
The existing DCO chat capability is available until June 24, 2015. 
 
The associated accreditation and IA documentation can be requested by government 
personnel by sending an email to the DCS mailbox 
(DISA.Meade.eis.mbx.dcs@mail.mil). 

 

  
DCS_User_Guide_20150126 62  

UNCLASSIFIED // FOUO 
 

https://extranet.if.afrl.af.mil/cg/software_tv.php
https://rie.afmc.af.smil.mil/cg/software_tv.php
mailto:DISA.Meade.eis.mbx.dcs@mail.mil


DCS User Guide 
March 6, 2015 

 

4.2 Initial Login 

• Select and double click the installed icon for the chat client 
• Wait until  the DoD warning screen appears 
• After selecting “ok” you are presented with a login screen (Figure 88) 
• If this is your first login, the screen will have no information 

 
Figure 88  New Account Window 

 
• Once this box appears, click on Options. 

 

 
 
 
 

• In the New Account Dialog Box, three tabs are displayed (Cross Domain, Advanced, and 
Authentication).   

Figure 89 Cross Domain Tab 
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• Select the “Cross Domain” tab.  Ensure “Disabled” is selected as the default (Figure 89).   
• Select the Advanced Tab (Figure 90) 

 

 
Figure 90 Advanced Tab 

 
• Under the Advanced tab: 

• Type chat.apps.mil  in My Chat Server:  
• Ensure “Resource” states  Transverse_1.8 
• Type chat.apps.mil for the Connection Host  
• Ensure that the “Port” is set to 5222 

 
• Select the Authentication Tab (Figure 91) 

– Select “Authentication Via Smartcard” 
– Select “Remember Certificate Selection” 
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Figure 91 Authentication Tab 

 
• Enter Persona User Name (PUN) in the Login box 

– For Defense Enterprise Email (DEE) Users 
• Email minus “@mail.mil” 
• Example:  Kurt.S.Karpov.CTR 

• Not a DEE User:  Please see Table 3 for PUN instructions. 
 
Select the “SAVE” or “LOGIN” button.  Do Not Select “Request Account” 
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• Entering with an existing account 
– Select the icon on the desktop 
– There is a wait, please do not keep clicking the icon 
– “Consent To Monitoring”  (Figure 92) will appear 

Table 3 Non-DEE PUN Instructions 

DCS TransVerse Username for Non-DEE Users  
 

If a user, such as Navy personnel, does not have a Defense Enterprise E-mail 
(DEE) account they will need to verify their “Persona Username”. This can be 
found two ways, using Outlook or milConnect.  

• Outlook 
o Look the user up in the Outlook Global Address List (GAL). 
o View the properties for the user. 
o On the “General” tab the “Alias” block will have the “Persona Username”. 

 i.e. john.a.doe.civ 
• milConnect 

o The user can log into milConnect at:  
https://pki.dmdc.osd.mil/identitymanagement/logoff/milconnect.dmdc.
osd.mil/proceed.do 

o Select appropriate certificate when prompted 
o Select “Ok” 
o Select milConnect from list “Websites that accept DS Logon” 
o Select “Ok” 
o From the “My Profile” tab select “Update and View My Profile”. 
o There are 3 possible tabs: 

 Personal Information 
• Everyone will have this one. 

 CTR, CIV and MIL 
• Some users will have only one of these and some may have 

both, i.e. dual persona. 
 On the “CTR”, “CIV” or “MIL” tab the “Persona Username” is 

located at the bottom of the “Personnel Status” section.  

 

  
DCS_User_Guide_20150126 66  

UNCLASSIFIED // FOUO 
 

https://pki.dmdc.osd.mil/identitymanagement/logoff/milconnect.dmdc.osd.mil/proceed.do
https://pki.dmdc.osd.mil/identitymanagement/logoff/milconnect.dmdc.osd.mil/proceed.do


DCS User Guide 
March 6, 2015 

 

 
Figure 92 DoD IT Consent Screen 

 
• Accept the consent.   
• The Transverse Login will appear (Figure 93). 
 

 

 
Figure 93 Client Login Screen 

 
• Ensure that the correct account information is present 
• Select “login” 
• Wait for the TransVerse client to connect and load (Figure 94) 
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Figure 94 TransVerse Loading 

 
Please call the Service Desk with any issues you may have installing TransVerse. 
 

4.3 TransVerse Screen Layout 

The TransVerse screen layout consists of four main parts: a Top-Level Menu Bar, 
Action Panels, Tool Bars, and a Display Area/Virtual Desktop. Error! Reference 
source not found. shows these parts in a typical configuration. 

 

 
 

Figure 95 Client Screen Layout 
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The TransVerse screen layout may be configured based on user preferences. See 
Section 7.2: Display Options for instructions to customize the screen layout. 

4.3.1 Top-Level Menu Bar 

The Top-Level Menu Bar provides access to most options available within TransVerse, 
via the main menu items listed below.  
 
Note: Items in each top-level menu category may vary depending on what services are 
enabled in Preferences. For instance, if Whiteboard is not enabled as a plug-in in 
Preferences, you will not see the Whiteboard item in the TransVerse menu.  
 
TransVerse Menu (Figure 96) provides the following options:  

• Disconnect – Connect or disconnect to/from the chat server.  
• User Search – Conduct a user search.  
• Chat – Select a user for opening chat.  
• Group Chat – Create or join a group chat.  
• Send Message – Send email-type message to other users or groups of users  
• Exit – Exit TransVerse.  

 

 
Figure 96 Menu Options 

 
TransVerse Edit Options Menu (Figure 97) provides the following options:  

• Edit my Profile 
• Preferences – Access to preference settings.  
• Saved Settings – Manage saved configuration settings or save current 

configuration. Saved settings can be selected from a dropdown during login.  
• Change Password – Change your current password. NOTE: Changing of 

passwords is not supported on most XMPP servers.  
• Accounts – Add, edit, or delete accounts; manage account passwords.  
• Colors – Manage color assignments for chat users.  
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• Look and Feel – Change the application’s look and feel (choices are operating-

system dependent).  
• Program Font Size – Change the program’s font size.  

 

 

Figure 97 Edit Options 
 
TransVerse View Options (Figure 98) provides the following options:  

• One-Click Action Panel View – By clicking any of the following options the 
associated Action Panel will unhide (if hidden) and will be brought into view 
(Note: Additional options may appear based on enabled plug-ins): 

o My Chat Sessions 
o My Contacts 
o My Places 
o Messages 
o Chat 
o Chat Logs 
o XML Console 

• Dock all Windows – Dock all floating (undocked) windows.  
• Compact Menu Mode – Set Compact Menu Mode to On, Off, or Auto to control 

whether to hide Top-Level menu bar options (if hidden, options can be expand 
upon clicking the Menus option).  

• Chat Style Alerts – Toggle on or off your chat alerts (set in Preferences).  
• My Chat Sessions – View a list of your current chat sessions.  
• Lookup Profile 
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Figure 98 View Options 
 
TransVerse Presence Options (Figure 99) provides the following options:  

• Select Standard Presence (status) – Set your current Presence (status) to any 
of the following standard statuses:  

o Online 
o Free for Chat 
o Away 
o Extended Away 
o Do not disturb.  
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Figure 99  Presence Option 
 

• Select Custom Presence (status) – Select a custom setting from a list (Figure 
100) to indicate a more specific Presence 

o Lunch 
o Be right back 
o Meeting 
o Gone home 
o Gone to work 
o Sleeping 
o Working  

 

Figure 100 Custom Presence Options 
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Window Menu – This Top-Level Menu option only appears when you are within a Chat 
or Group Chat Action Panel.  The following option (Figure 101) is provided if the 
Chat/Group Chat session grouping preference is set to Tabs: Dock/Undock 
 
 

 
Figure 101 Dock/Undock Option 

 
 

• The following options (Figure 102) are provided if the Chat/Group Chat session 
grouping preference is set to Virtual Desktop:  

o Auto Tile  
o Tile Horizontal  
o Tile Vertical  
o Tile Grid  
o Cascade Windows  
o Undock  

(Note: For more information regarding the above Virtual Desktop window options, 
please refer to the Window Menu section):  
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Figure 102 Chat/Group Chat Grouping 
 
Help - Provides the following options:  

• TransVerse Help – Access searchable Help tool.  
• About – License, copyright, and staff information.  
• System Information – Version, memory, and directory information.  

The green lock icon to the right of the menu indicates a secure connection.  

4.3.1.1 TransVerse Action Panels Concept 

Users have the ability to access the many core functions of TransVerse through the use 
of Action Panels. Each function has its own Action Panel (Figure 103). Access Panels 
can be added to the TransVerse Display Area by selecting a function from the View 
Top-Level Menu option.  
 
Functional Action Panels can be “docked,” (snapped to the main TransVerse window) or 
“undocked” (moved into a floating window). Action Panels for My Chat Sessions, My 
Contacts, and My Places can be docked left or right. All other Action Panels can be 
docked right only. 
 
Hint: Docking and undocking panels is simple. Just select the "Dock" or "Undock" icon 
from the Action Panel Tool Bar, or right-click in the Action Panel to access dock/undock 
options.  
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Figure 103 Action Panels 

 
 
Below are brief descriptions of the core functions accessible through use of Action 
Panels:  

• My Chat Sessions lists all your open chat sessions (individual and group). 
TransVerse can also remember chat sessions between logons/logoffs and list 
them in the Chat Sessions area.  

• My Contacts displays a listing of contacts and their availability to chat. When 
you subscribe to the presence of other users, those users are added to your My 
Contacts list.  

• My Places lists servers and available chat rooms.  
• Messages display the messages a user receives.  
• Group Chat allows you to view all current multi-user Group Chat rooms.  
• Chat Logs displays the history of a user’s previous chat sessions.  

Note: Additional Action Panels may be available based on which plug-ins are enabled.  

4.3.1.2 Tool Bar Layout 

Tool Bars provide icons for quick access to frequently used Top Level Menu Bar 
capabilities. There are two types of Tool Bars in TransVerse: 

 
• Main Tool Bar – Located below the Top-Level Menu. Provides an alternate 

navigation tool when the Single Pane layout is selected rather than the Tabbed 
Panes layout. Contains icons for Disconnect/Connect; Dock all Windows; and 
buttons for any Action Panels in use (such as Messages or My Places). 

 
Enable the Main Tool Bar by selecting Edit—Preferences—General.  In the 
“Window Layout” field (Figure 104), select the “Single Pane” option. The Main 
Tool Bar can be displayed/hidden by checking the “Show Main Tool Bar” box. 
Alternatively, the Main Tool Bar can be displayed/hidden through the View menu. 
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Figure 104 Window Layout 

 
 
• Action Panel Tool Bar – Located at the top of each Action Panel. Contains the 

icons specific to an Action Panel. See page 102 for descriptions of each icon. 
 
 

 
Figure 105 Tool Bars 

 

4.4 Account Management 
When using TransVerse, you may need to edit an existing account, create a new 
account, or delete existing accounts. These actions can be completed through the 
Manage Accounts window.  
 
Access the Manage Accounts window by clicking the Manage Accounts button(Figure 
106)  within the TransVerse Login window or selecting Edit > Accounts in the Top-Level 
Menu. Users with multiple accounts (also called profiles) will see all their accounts listed 
here. 
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Figure 106 Edit Accounts 

4.4.1 How to edit an account 

1. Access the Manage Accounts window using the instructions above.  
2. Select an account from the Accounts list and press Edit.  
3. The Edit Account window will appear. Here the login, password, server and other 

preferences can be modified.  
4. From the bottom of the Edit Account window, select Options to edit other 

account information (See Account Options for descriptions of each additional 
option).  

5. After making changes to an account’s settings, press Save to retain all changes 
and return to the Manage Accounts window. Press Cancel to discard changes.  
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Figure 107 Manage Accounts Window 

4.4.2 How to delete an account 

Access the Manage Accounts window (Figure 107) using the instructions above.  

1. Select an account from the Accounts list, and press Delete.  
2. A “Confirm Deletion” window appears. Verify that the account you have selected 

is the one you wish to delete.  
3. Press Yes to delete or No to cancel.  

4.4.3 How to create a new account 

1. Access the Manage Accounts window using the instructions above.  
2. Select New. The New Account window appears.  
3. Follow the steps from the Login section to create a new account.  

4.4.4 Advanced Account Options 

The following advanced account options (Table 4) are available by clicking Options 
from the Edit Account Window and then selecting the Advanced tab.(Error! 
Reference source not found.)  
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Figure 108 Edit Account Window 

 

Resource Represents a specific session or connection (e.g., an XMPP client or location). A 
user may maintain multiple connected resources simultaneously, with each 
designated by a distinct resource identifier, which is commonly used to indicate 
location of user or machine being used (e.g., TransVerseLaptop, TransVerseWork). 
This can be useful to other users since it may indicate the stability and reliability of 
the user’s connection.   

Connection Host Used when the XMPP domain for a server does not match the server name. Typically, 
Domain Name Service (DNS) would be configured to handle such a situation. 

Port The port number to connect to the server. This will automatically be set to 5223 if 
the secure socket layer (SSL) connection type is selected, and to 5222 if transport 
layer security (TLS) is selected. Servers can use ports other than 5222 and 5223, 
but typically do not. One example of a differing port usage is jabber80.com, which 
uses port 80 in order to circumvent firewall issues if sites block port 5222 and 5223. 

 
Note: Port and Connection Type default to 5223/SSL for a CG 1.x Connection or to 
5222/TLS for a CG 2.x connection (selected on the Cross Domain tab).   

Default Priority Used to assign priority to one user session over another when a user is connected 
multiple times with the same account and differing resources. A lower number value 
indicates a higher priority. If a plain message or chat message were sent to the user 
without a resource identifier, the server would use the priority value to determine 
which client session to send the message to.  

XMPP Timeout Set the wait time for a response from the XMPP server. Default is 30 seconds. 
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Connection Type Select TLS, SSL, or Plain Unsecured: 

• TLS: By default, the client will negotiate a TLS connection if the server 
supports it. The preferred setting is to let the client auto-negotiate the 
security level with the server. The TLS protocol allows client/server 
applications to communicate in a way designed to prevent eavesdropping, 
tampering, and message forgery. TLS provides endpoint authentication and 
communications privacy. 

• SSL: This option should be selected if the server only supports the legacy 
SSL mode for handling secure connections (ask your system administrator). 

• Plain Unsecured: This setting is recommended for high-latency, low-
bandwidth setups. 

Note: Port and Connection Type default to 5223/SSL for a CG 1.x Connection or to 
5222/TLS for a CG 2.x connection (selected on the Cross Domain tab).   

Auto reconnect Configures the application to automatically attempt to reconnect if disconnected from 
the server. 

Use Compression 
(if available) 

TransVerse supports using stream compression to the server. This is similar to 
zipping a file. For TransVerse to use compression, the server must also support it. 
Using compression results in lower bandwidth use but higher central processing unit 
(CPU) usage (on the client and the server) due to the compressing and 
uncompressing of the packets. Using compression is recommended and is on by 
default. 
 

 
 

      

Table 4 Manage Accounts Advanced Options 
 

4.4.5 Authentication Options 

The following authentication options are available by clicking Options from the Edit 
Account Window and then selecting the Authentication tab.  
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Figure 109 Manage Accounts Authentication Options 

 
 
Three authentication options are supported.  

• Authenticate via XMPP account. This is the default.  
• Authenticate via SmartCard. This requires a TLS connection.  
• Authenticate via Single Sign-On.  

 
SmartCard login provides the option to authenticate using a SmartCard (instead of user 
name and password) - like a CAC would be used to login to a computer.  
 
The XMPP server must support SmartCard authentication for this option to be used. 
Assuming your XMPP server supports SmartCard login, select the ‘Authenticate via 
SmartCard’ check box. A valid SmartCard Library value must be supplied. The 
SmartCard Library setting must point to the operating system library that interfaces with 
the SmartCard reader. If you do not know what this value should be, contact your 
system administrator.  
 
A SmartCard will most likely have multiple certificates. In order to remember the 
certificate used and avoid being prompted to choose a certificate at the next 
authentication, check the "Remember Certificate Selection" checkbox.  
 
NOTE: In order for the XMPP Chat Server to support SmartCard authentication, the 
locally authenticated username must match the common name in the SmartCard 
certificate. For example, in OpenFire code would have to be written to map the common 
name of the user’s Smartcard certificate to the user’s LDAP or the locally stored 
username.  
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4.5 Setting your Preferences 

Through the Preferences menu item (Figure 110), you can customize the appearance of 
your TransVerse client to meet your user needs and your personal preferences.  
 

 
Figure 110 Preferences Menu 

 
 
Select Edit > Preferences from the Top-Level Menu to edit preference settings in these 
categories:  

• Alerts  
• Chat  
• Chat Logs  
• Display  
• General  
• Group Chat  
• My Chat Sessions  
• My Contacts  
• Plug-ins  
• Translation  

Note: An additional Audio category may exist if the associated plug-in has been 
distributed. Please refer to the Audio section for more details.  
 
Navigating the Preferences Window:  
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The Preferences window lists the preference categories on the left and displays the 
options for each category on the right. Click on a category name to display that 
category’s preference options on the right. 

If a checkmark appears next to a setting option, which means the option is enabled. If 
no checkmark appears, that option is disabled. You can enable or disable any option by 
clicking the checkbox next to it.  

You can change settings in multiple categories before closing the Preferences window. 
Simply navigate to the other categories using the list on the left. Once all selections are 
complete, click Save to close the Preferences window and retain all changes. Click 
Cancel to restore settings to the last saved action and close the Preferences window.  
 
Some changes require a restart of TransVerse in order to take effect. If you have 
selected any of these settings, TransVerse will prompt you to restart after clicking Save.  
 
After clicking Save, if you are not prompted to restart and your selected settings are not 
implemented, you should manually restart TransVerse.  

4.5.1 Alerts Preference 

The Alerts Preferences (Figure 111) provides options for how you are alerted to new 
messages or to a contact changing Online/Offline status.  

• Chat Style Alerts – Enable to choose one or more of the three alert settings to 
indicate when new chat messages have arrived. Any combination of these 
settings can be enabled.  

o Window to Front on New Message – New messages automatically open 
on top of other panels or tabs.  

o Flash Window Icon on Alert – TransVerse icon flashes red and chat 
session tab turns red upon receipt of new message.  

o Desktop Alert on New Message – New messages appear briefly in lower 
right corner of screen.  

• Desktop Alert for Contacts Online/Offline – Enable for alerts in lower right corner 
of screen for Contacts changing Online/Offline status.  

• Play Sound on new messages – Enable for a sound to play with each incoming 
message. You can click Browse to select a new sound file from your local 
machine or network.  
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Figure 111 Alerts Preferences Options 

4.5.2 Chat Preference 

The Chat Preferences (Figure 112) provides options for individual chat settings. See 
Group Chat preferences for information regarding Group Chat session preferences.  
 

• Session Grouping – Select how multiple chat windows will be grouped when 
docked to the main TransVerse window within the Chat Action Panel.  

o Virtual Desktop – This option allows multiple chat windows to display at 
the same time within the Display area. Chat windows can be tiled 
vertically, horizontally, in a grid formation or cascaded. See the Window 
Menu section for more details.  

o Tabs – This option stacks chat windows in a tabbed format in the Display 
Area, allowing only one chat window to display at a time.  

 Place Tabs on Bottom – If enabled, tabs for multiple chat session 
windows appear at the bottom of the Chat Action Panel.  

o Dock New Chat Sessions – When enabled, new chat sessions are 
automatically docked and as result appear within the Chat Action Panel. If 
disabled, new chat sessions are automatically undocked.  

o New Chat Sessions to Front – When enabled, new incoming chat 
sessions are brought to the front of the TransVerse display.  

o Force Instant Messages to Chat – In TransVerse, you can exchange chat 
messages in a Chat or Group Chat or can send email-like Messages to 
other users via the Messages Action Panel. When this option is enabled, 
all Messages appear within the Chat Action Panel instead of the 
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Messages Action Panel. When disabled, all Messages appear within the 
Messages Action Panel.  

o Announce Presence Changes – Enable to receive notification within chat 
window when users you are chatting with change presence status.  

o Enter = Send – Enable to use Enter key to send a typed chat message. 
Disable to use Enter key to make a line return of text. (Note: Your 
selection in this preferences window sets the default for the Enter key 
function. You may temporarily change the Enter key function in a chat 
session by clicking the “Enter = Send” icon in the chat window.)  

o Show Timestamps – Enable to see the timestamp for each chat message. 
(This setting carries over to Group Chat sessions also.)  

 Timestamp Format – Select the format for timestamp display in 
chat and group chat sessions.  

o Enable message time to live (TTL) – Enter the number of minutes to 
elapse before an undelivered message expires.  

 

 

Figure 112 Chat Preferences Options 
 

4.5.3 Chat Logs Preference 

The Chat Logs Preferences category provides options storing chat logs.  
 

• Chat Logs Directory (Figure 113) – Configure the location of the chat log files. 
Click Browse to select a directory on your local computer or a shared network 
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drive. Click Default to store the chat logs files in the log directory that exists in 
USER_HOME_DIRECTORY\.transVerse directory. This default directory is 
named logs-“username”@”servername” per the account used.  
 

 
Figure 113 Chat Logs Preferences Option 

 

4.5.4 Display Preferences 

The Display Preferences (Figure 114) provides options for configuring the screen layout 
and appearance.  
 
Note: In order for any display preference change to properly take effect, you must 
manually restart TransVerse.  

• Display URL Referenced in Images in Chat 
• Show HMTL Version of Messages When Received – When enabled, font 

selections such as bold, underline, italics, etc. appear within chat room. When 
disabled, font selections are ignored and messages appear as plain text.  

• Abbrieviate Long URLS 
• Display Emoticon Images – Toggle whether to display the corresponding image 

for an emotiocon.  
• Chat Display Style – Toggles the chat windows between a boxed view or the 

classic view. In the boxed view, each message within the chat room is displayed 
within its own box, with the username and timestamp displayed at the top of each 
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box. In the classic view, chat messages are not boxed and simply display in a 
vertical fashion.  

• Chat Font – Set the font for Chat/Group Chat sessions. Select from several fonts.  
• Chat Font Size – Set the text size for Chat/Group Chat sessions. Select as small 

as 6 or large as 20.  
• Chat Font Bold – Set whether the font for Chat/Group Chat sessions always 

displays in bold font.  

 
Figure 114 Display Preferences Options 

 
 

4.5.5 General Preferences 

The General Preferences (Figure 115) provides options for configuring the screen 
layout and appearance.  
Note: In order for any general preference change to properly take effect, you must 
manually restart TransVerse.  
 

• Compact Menu Mode – Select On, Off, or Auto. This option can also be changed 
from the View menu item.  

• Keep Undocked Windows On Top – Enable to keep undocked windows in front 
of all other applications (including main TransVerse window).  

• Auto-away when idle (minutes) – Enable to set presence to “Away” after a 
specified number of minutes of inactivity.  
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• Minimize to System Tray (if supported) – Toggle whether to only show 

TransVerse icon in the system tray when it is minimized (i.e. not show it on the 
task bar).  

• Show Classification Banners – Toggle whether to show classification banners on 
the main window and any undocked window. By default, banners are shown 
when in cross-domain mode.  

• Window Layout – Select the Window Layout. Choices are Single Pane (only one 
Action Panel can be displayed at a time within the display area) and Tabbed 
Pane (all viewable Action Panel tabs appear within the display area).  

o Show Main Toolbar – This option only applies to the Single Pane view. 
When enabled, the main tool bar displays below the Top-Level Menu bar 
and contains buttons for each of the action panels.  

o Use 1-row Scrolling Tabs - This option only applies to the Tabbed Pane 
view. Enable to allow the user to scroll through the Action Panel tabs 
within the Display Area if the size of the TransVerse window is too small 
for all tabs to display at once. Disable to display the Action Panel tabs in 
multiple rows if the size of the TransVerse window is too small for all tabs 
to display within a single row.  

• Look and Feel – Selects a different theme application. The list of available 
themes is operating system-dependent. The look and feel you choose will only 
change your view, not what other users see.  

• Time Zone – Select desired time zone. Message times are displayed according 
to this setting.  

• Locale – Sets the language for TransVerse interface. Choices are English, 
Spanish, French, Korean, and Japanese.  

• Default Pane – Select which Action Panel appears in the Display Area when you 
connect to TransVerse.  
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Figure 115 General Preferences Options 

 
 

4.5.6 Group Chat Preference 

The Group Chat Preferences (Figure 116) category provides options for Group Chat 
session settings. See Chat preferences for configuring individual chat session 
preferences.  

• Session Grouping – Select how multiple Group Chat windows will be arranged 
when docked to the main TransVerse window within the Group Chat Action 
Panel.  

o Virtual Desktop – This option allows multiple chat windows to display at 
the same time within the Display Area. Chat windows can be tiled 
vertically, horizontally, in a grid formation or cascaded. See the Window 
Menu section for more details.  

o Tabs – This option stacks chat windows in a tabbed format in the Display 
Area, allowing only one chat window to display at a time..  

 Place Tabs on Bottom – If enabled, tabs for multiple chat session 
windows appear at the bottom of the Group Chat Action Panel.  

• Reenter Rooms from Last Session – Enable to automatically reenter group chat 
rooms from user’s last session upon the next login to TransVerse.  
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• Announce Presence Changes – Enable to receive notification within chat window 

of presence changes for Group Chat members.  
• Announce Role Changes – Enable to receive notification within chat window of 

role changes for Group Chat members.  
• Automatically Accept Room Invitations – Enable to have room invitations 

automatically open into Group Chat sessions, skipping the manual acceptance 
step.  

• Show Full Username Addresses in Participants List – Enable to list entire Jabber 
ID (JID) of each user in Group Chat Participants List. If disabled, only the 
username section of JID appears.  

• Show Participants on Right – If enabled, the room participants list is displayed on 
the right side of the Group Chat window (by default, it is shown on the left).  

• Last Name First in Participants List – If enabled, the entries in the participants list 
will be shown in the form “Lastname, Firstname”. Note: This preference setting is 
dependent on Show Full Username Addresses in Participant List being disabled.  

• Hide Text Input Area When Inactive – If enabled, when multiple group chat 
rooms are open within the Virtual Desktop, the text input area will only appear 
within the group chat room actively being used.  

• Display Sent Messages Immediately – Typically, sent Group Chat messages are 
not displayed until they are returned from the server. In poor network conditions, 
it may be preferable to display sent messages immediately. If enabled, sent 
messages are displayed immediately preceded with a clock icon. The clock icon 
is removed upon receipt of the message back from the server.  

• Enable Fast Reconnect – Enable to allow client to reconnect automatically after a 
network outage.  

• Limit Room History – If enabled, the selected values determine how many lines 
of chat will appear from a room’s history when you enter a Group Chat room. 
Select from an hours range of 0 to a max of 9999 and a minutes range of 0 to a 
max of 999.  

• Limit Room History Lines To – If enabled, the selected number determines how 
many lines of chat will appear from a room’s history when you enter a Group 
Chat room. Select from a range of 0 to a max of 999.  

• Use Room Nicknames – If enabled, the default nickname, or assigned room 
specific nickname, will be used in Group Chat. The nickname will be displayed in 
chat and the participants list instead of the user name. 
Note: Nicknames may be assigned on a per room basis by right clicking on a 
room in My Places and selecting the Assign Nickname menu item or right clicking 
on the main Group Chat toolbar and selecting the Assign Nickname menu item. If 
a room specific nickname has not been supplied, the Default Nickname will be 
used instead.  

o Default Nickname – The value entered for Default Nickname represents 
the nickname used in Group Chat when an assigned room specific 
nickname has not been supplied.  

o Clear All Nicknames – By clicking the Clear button, all assigned room 
specific nicknames are removed so the default nickname is used across 
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all group chat rooms. A dialog will be displayed asking to confirm this 
action.  

 
Figure 116 Group Chat Preferences Options 

 

4.5.7 My Chat Sessions Preference 

The My Chat Sessions Preferences (Figure 117) provides options for managing and 
displaying contacts.  

• Display Mode  
o Window Mode - Display chat room windows in display area.  
o Toolbar Mode - Display buttons for chat rooms in tool bar.  
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Figure 117 My Chat Sessions Preferences Options 

 
 

4.5.8 My Contacts Preference 

The My Contacts Preferences (Figure 118) provides options for managing and 
displaying contacts.  

• Show Only Online Contacts – Enable to show only contacts that are online. 
(Note: This option controls the default setting for showing online contacts. To 
temporarily adjust which users appear in My Contacts, use the icons in the My 
Contacts Action Panel Tool Bar.) Alternatively, disable this option to display all 
contacts regardless of presence status.  

• Automatically Approve Contact Subscription Requests – Enable for automatic 
approval of any contact subscription requests from users who wish to add you to 
their My Contacts list and thus subscribe to your presence.  

• Show Full Username Addresses instead of Nickname – Enable to list entire 
Jabber ID (JID) of each user listed within My Contacts. If disabled, only the 
username section of JID appears.  

• Enable Profile (vCard) Support - Enable to display vCard data for contacts.  
• Query Server for Contacts Automatically - Enable to retrieve contact information 

on login.  
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Figure 118 My Contacts Preferences Options 

 
 

4.5.9 Plug-ins Preference 

The Plug-ins Preferences (Figure 119) category provides options for enabling and 
disabling plug-ins. In TransVerse, plug-ins are simply functions that you can turn on or 
off.  

Note: Several of these plug-ins require a restart of TransVerse in order to take 
effect.  

• Enable Buddy Bar – Enable for a visual display of selected contacts and their 
presence indicator. The Buddy Bar displays at the bottom of the TransVerse 
window. Contacts can be added to the Buddy Bar through use of the Add Status 
Light icon.  

• Enable IQVersioning – Enable to reduce traffic when a query to the server would 
return the same response as a previous query  

• Enable Translation – Enable to connect the client to a translation server that 
allows for translation of text. (Note: After enabling the Translation option, 
configuration with the Translation server must be completed. See Translation 
Preferences section for more details.)  

o This function is not supported.  Do not enable it. 
• Enable Contacts – Enable to display My Contacts panel.  
• *Enable “My Chat Sessions” – Enable to display the My Chat Sessions 

tab/window which lists all your open chat sessions (individual and group).  
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• *Enable Places Tab – Enable to display the My Places tab/window which lists the 

rooms available for Group Chat.  
• *Enable Online Tab – Enable to display the Online Users tab/window which lists 

the presence (status) of online users on a particular server within the same 
domain.  

o This function is not supported.  Do not enable it. 
• *Enable File Transfer- Enable to display the File Transfer tab/window which 

allows exchange of files to other same-domain TransVerse users.  
o This function is not supported.  Do not enable it. 

• Enable Chat Log – Enable to display chat logs.  
• *Enable XML Console – Enable to display the XML Console tab/window which 

shows the raw XML messages that are being sent and received by the 
Transverse client. Software developers and system administrators normally use 
this option for testing.  

• Enable Form Server – Enable to publish and subscribe to Dynamic Data Forms.  

*If option is enabled but tab/window does not display, select item from the View menu 
within the Top-Level Menu Bar to display. 
 

 
Figure 119 Plugin Preferences 

 

4.6 Display Options 

TransVerse is versatile and flexible, offering several one-click options for intuitively 
adjusting its display. This means TransVerse simplifies communications. Multiple chat 
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windows, messages, and chat logs, are easily displayed with just a few clicks. Panels 
can be tucked out of sight when not needed, and can be easily retrieved later.  
 
The sections below will guide you through how to use TransVerse display options. The 
configuration possibilities are many and allow you the freedom to arrange windows as 
best meets your needs.  

• Virtual Desktop vs. Tabs  
• Window Menu  
• Buddy Bar  
• Display Tips  
• Right-click Display Options  

4.6.1 Virtual Desktop 

In the Virtual Desktop view (Figure 120), if multiple chat windows are actively in use, the 
windows can be tiled or cascaded, allowing multiple chat windows to be viewed at the 
same time. For more tiling options, please refer to the Window Menu section.  
 
Benefits of using Virtual Desktop:  

• Consolidates Chat / Group Chat windows in one place  
• One-click access to minimize/maximize Virtual Desktop, easing window 

management  
• Instant ability to configure tiling options  

 
Figure 120 Virtual Desktop - Cascade Windows 

 
To enable Virtual Desktop, go to Edit > Preferences and select "Virtual Desktop" in the 
Session Grouping area for Chat and/or Group Chat (depending on what you prefer). 
You will need to exit and reenter any current Chat or Group Chat sessions in order for 
the changes to take effect.  
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4.6.2 Window Menu 

The Window Top-Level Menu item will appear when you click into a docked chat or 
group chat session. Choices in this menu item depend on whether the session grouping 
preference is set to either Virtual Desktop or Tabs.  

 
Figure 121 Virtual Desktop Display Window 

 
All Window options are available in the Virtual Desktop display (Figure 121). The 
Tabbed view offers the Undock / Dock option only. 

4.6.2.1 Tabbed View 

You can use the Tabbed Panes view (Figure 122) for grouping multiple Chat or Group 
Chat session windows. This setting stacks your Chat or Group Chat windows in a 
frame with tabs for switching between windows. The Window menu item will be 
available with the Dock/Undock option (see Section 3.4.2: Window Menu). 
 
Tabbed Panes can be enabled through Preferences (Chat or Group Chat options). By 
default, tabs are set to appear at the top of the Chat or Group Chat windows. You can 
set the tabs to appear on the bottom in Chat or Group Chat Preferences. 
 
In the Tabbed view, the only option available within the Window menu is the following:  

• Undock/Dock - You can undock or dock the entire Chat or Group Chat pane, 
containing all open Chat or Group Chat windows.  
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Figure 122 Tabbed Panes in Group Chat 

 

4.6.2.2 Virtual Desktop View 

In the Virtual Desktop view (Figure 123), the following options are available within the 
Window menu:  
 

• Auto Tile – With Auto Tile enabled, all windows in the Virtual Desktop area 
display in an evenly spaced arrangement based on which tiling style you have 
selected (horizontal, vertical, or grid). Also, with Auto Tile enabled, when the 
TransVerse window is resized, all tiles within the Virtual Desktop pane will 
automatically resize to fill up the Virtual Desktop.  

• Tile Horizontal - This tiling option places Chat or Group Chat windows one 
above the other, so that they are stacked within the Virtual Desktop from top to 
bottom.  

• Tile Vertical - This tiling option places Chat or Group Chat windows one beside 
the other, so that they are organized within the Virtual Desktop from left to right.  

• Tile Grid - This tiling option places Chat or Group Chat windows in a grid pattern, 
so that they tile the Virtual Desktop in columns and rows. (Note: By default, the 
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grid pattern emerges with three or more windows. With two chat windows, a 
horizontal tile pattern will be used until a third window is added.)  

• Cascade Windows - This tiling option stacks Chat or Group Chat windows on 
top of each other so that the title bars of each are still visible. Auto Tile disables 
when Cascade Windows is selected.  

• Fill with Top - This option is available when two windows are open in the Virtual 
Desktop. It is a quick method to adjust the two window sizes vertically so that 
they will fill the virtual desktop. Select "Fill with Top" when you want the top 
window to expand vertically to fill empty Virtual Desktop space, leaving the 
bottom window the same size. Auto Tile disables when Fill with Top is selected.  

• Fill with Bottom - This option is available when two windows are open in the 
Virtual Desktop. It is a quick method to adjust the two window sizes vertically so 
that they will fill the virtual desktop. Select "Fill with Bottom" when you want the 
bottom window to expand vertically to fill empty Virtual Desktop space, leaving 
the top window the same size. Auto Tile disables when Fill with Bottom is 
selected.  

• Undock/Dock - You can undock or dock the entire Chat or Group Chat pane, 
containing all open Chat or Group Chat windows.  

 

 
Figure 123 Virtual Desktop - Tile Grid 

 

  
DCS_User_Guide_20150126 98  

UNCLASSIFIED // FOUO 
 



DCS User Guide 
March 6, 2015 

 

4.6.3 Buddy Bar 

The Buddy Bar (Figure 124) provides a set of status lights indicating the presence of 
buddies/contacts of your own choosing. This function makes it easy for you to identify at 
a glance whether your selected contacts are online, away, or ready to chat.  

 
Figure 124 Buddy Bar 

 
You can undock the Buddy Bar by clicking the Undock icon on the right, or bring it back 
by clicking the Dock icon, which appears once it is undocked. At any time, you can click 
the Add Status Light button (red plus sign by buddy image), and enter the Jabber ID 
(JID) of any user on your roster, or scroll through the popup list that appears in order to 
find them. They will then be added in sequence left-to-right, so you can track their 
presence easily. Right-click on any status light to delete it from the Buddy Bar. 
 

4.7 Display Tips 

4.7.1 Right-Click  

In each Action Panel, you can right-click to access panel-specific display options. These 
options vary from panel to panel, but in general they include the following: 
 
• Option to display or hide the panel’s tool bar 
• List of icons from the panel’s tool bar 
• One-click option to close the panel 
• Docking options for panel 
• “Always on Top” option for panel 

 
More details are available in each Action Panel’s section in this User’s Guide. 

4.7.2 Panel 

Hide/Show Arrows  
If any action panels are docked to the left, the visible space is split between the left and 
right. Multiple action panels may display on the left while only one tabbed action panel 
will display on the right. In order to have either the left-hand or right-hand side of the 
visible area to take up all of the space the black Hide/Show arrows can be clicked.  
 
Click and Drag Undock  
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You can click and drag a docked Action Panel to undock it. Simply place the cursor to 
the right of the tool bar area of the Action Panel (where the room name is), then click, 
drag, and release.  
 
If multiple tiles are visible within the Virtual Desktop, when a tile is undocked a 
placeholder will be kept to remember the original position of the tile. In order to place 
the tile back into its original position, click the red x in the upper right-hand corner of the 
tile.  
 
Resize Action Panel  
You can resize most windows and Action Panels in TransVerse using the resize cursor. 
Hover over a corner of the TransVerse window or over any other edge of an area you 
would like to make bigger or smaller. If that edge can be moved, the resize cursor will 
be visible, and you can click and drag the edge to the desired position.  
 
Dock all Undocked Windows  
Select “Dock All Windows” from the View menu item to instantly dock all floating 
windows.  

4.7.3 Additional Tips 

• Click the black right and left arrows to hide or expand current Action Panels. 
You will find these arrows on the vertical pane divider between Action Panels. 

• You can click and drag a docked Action Panel to undock it. Simply place the 
cursor to the right of the tool bar area of the Action Panel, then click, drag, and 
release. 

• Rearrange tiles in the Virtual Desktop area—simply click and drag by the title bar 
(area at the top of the pane where you see the chat recipient’s name). You can 
also click and drag by the area to the right of the tool bar to pull the tile out of 
the Virtual Desktop. 

• You can resize most windows and Action Panels in TransVerse using the resize 
cursor. Hover over a corner of the TransVerse window or over any other edge of 
an area you would like to make bigger or smaller. If that edge can be moved, the 
resize cursor will be visible, and you can click and drag the edge to the desired 
position. 

• Select View—Dock All Windows from the Top-Level Menu Bar to instantly dock 
all floating windows. 

4.8 Saved Settings 

All client settings (less account information) and state may be saved and selected for 
use at login. Follow the steps below to use the Saved Settings feature.  
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4.8.1 Save New Settings 

1. With TransVerse running and configured with desired settings and chat sessions 
open, select Edit—Saved Settings. The Manage Settings dialog opens (Figure 
125), displaying any existing saved settings. 

2. Click the Save Current Settings button. You are prompted for a name. 
3. Enter the desired name and press OK. 
4. Click the Close button to close the Manage Settings dialog. 

 
Figure 125 Manage Settings 

4.8.2 Delete Saved Settings 

1. Within TransVerse, select Edit—Saved Settings. The Manage Settings dialog 
opens, displaying the existing saved settings. 

2. Select the existing saved settings that you want to delete from the Saved Settings 
list (Figure 126). 

3. Click the Delete button to delete the saved settings. 
4. Click the Close button to close the Manage Settings dialog. 
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Figure 126 Delete Saved Settings 

4.8.3 Select Saved Settings at Login 

At login, if any saved settings exist, a “Saved Settings” drop down will be displayed 
below the “Password” field of the login dialog. Select the desired saved setting and 
proceed with login. The saved settings will be applied and the client will be in the state 
that existed when the settings were saved. 

4.9 Action Panels 

4.9.1 Chat 

TransVerse allows you to conduct multiple one-to-one and group chat sessions 
concurrently. From chat, you can also share files with other users.   TransVerse uses 
the open-standards-based eXtensible Messaging and Presence Protocol (XMPP), an 
XML-based instant messaging, presence and multi-user text chat protocol. With same-
domain users, you can engage in both one-to-one and group chat.  
 
This section provides instructions for the following:  

• Start an Individual (One-to-One) Chat Session  
• Group Chat  

o Start/Enter a Group Chat Session  
o Invite Users to a Room  
o Group Chat Features  

• File Transfer (same-domain only)  
• Search for Text in Chat Window  
• Text Monitoring and Keyword Highlighting  

4.9.1.1 Chat Action Panel Tool Bar Icons 

Table 5 Chat Action Panel Tool Bar Icons, shown below, gives you a description of the 
Icons you will encounter. 
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Table 5 Chat Action Panel Tool Bar Icons 

4.9.1.2 Start an Individual Chat Session 

Individual or One-to-One chat sessions can only be used when both users reside on the 
same domain.  Multiple methods can be used to start a chat session with another 
individual user.  
 
From Top-Level Menu:  

1. From the TransVerse menu item (Figure 127), select “Chat".  
2. A window appears. Manually type in a Jabber ID (JID) or select one from the 

drop-down menu (Figure 127).  
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Figure 127 Chat Selection 

 
 

From My Contacts:  
1. From My Contacts, right-click on a contact and select “Chat”, or double-click on a 

user’s name.  
 

4.9.2 Group Chat Session 

The Group Chat Action Panel groups windows of multi-user chat sessions. 
TransVerse users can participate in multi-user chat using Group Chat rooms. 

4.9.2.1  Group Chat Action Panel Tool Bar Icons 

Table 6 Group Chat Action Panel Tool Bar Icons, describes the icons displayed in the 
Group Chat display area tool bar. Icons that change appearance (toggle) once their 
original function is enabled are shown here in pairs. 
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Table 6 Group Chat Action Panel Tool Bar Icons 

 

4.9.2.2   Enter Group Chat Session 

Multiple methods can be used to start a Group Chat. 
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From My Places (Figure 128): 
1. Double-click on a room to enter, or 
2. Right-click on the room and select “Enter Room”, or 
3. Select the room and click the “Enter Room” icon. 
4. If desired, click on the “Invite” icon and invite other participants to the 

chat session.  
 

 
Figure 128 My places Group Chat 

 
 
 
From the Top-Level Menu Bar: 
1. Select TransVerse—Group Chat. 
2. A Join Group Chat window appears (Figure 129).  You can search for existing 

rooms or create a new room from this window. 
a. To search for rooms: 

i. Click Find Rooms. 
ii. A list of available rooms will display. Double-click a room to enter. 

b. To create a room: 
i. Enter room name, a password if desired, and your nickname as you want it 

to appear in the room. 
ii. Click OK. 

iii. If an error message appears, click Yes. 
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iv. The room will open, with a room message reading “This room is locked from 

entry until configuration is confirmed.” See Section 3.8 for room 
configuration instructions. 

3. After entering a room or creating a new one, a chat window appears. 
4. If desired, click on the “Invite” icon to invite other participants to your chat session. 

 

 
Figure 129 Group Chat Create a Room 

 
The group chat room interface includes the following features: 
• Language abbreviations by names indicate other user’s language (if different than 

own). 
• The JID for the room is centered below the classification banner (if banners are 

enabled). The room JID will be in the format of roomname@servername. For 
example, test_room@conference.jabber.com. 

• Users can select a presence specific to that chat room from the “Room 
Presence” drop-down menu.  Selecting a presence in the room will not change 
your overall presence in TransVerse. 

• The voting buttons (icons show a “thumbs up” and a “thumbs down” for 
yes and no, respectively) can be clicked once to display a vote and 
clicked again to remove vote. 
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Figure 130 Group Chat (undocked) 

 

4.9.2.3   Group Chat Room Configuration 

You will be prompted to configure any room you create. Rooms must be configured 
before other users are allowed to access them. 
 
At any time, you may reconfigure a room you have created by selecting the “Room 
Configuration” icon from the Group Chat display area tool bar within that room. 
 
Figure 131 shows an example of the default Room Configuration window. Available 
settings will vary depending on the server connection type; therefore, this window may 
vary. To accept the default configuration, click OK. 
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Figure 131 Group Chat Room Configuration 

 
The window can be expanded to display more detailed settings by clicking Options.  
Figure 132 show the expanded window with all the available settings, and Table 7 
Room Configuration Settings describes each setting. 
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Figure 132 Room configuration Expanded 
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Table 7 Room Configuration Settings 

 

Description Text listed in My Places to identify room. (Room Description 
may differ from Room JID) 

Allow Occupants to 
Change Subject  

Feature currently not available in TransVerse. 

Maximum Room 
Occupants 

10, 20, 30, 40, 50, or None. 

Roles for Which 
Presence is 
Broadcast  

Select/ deselect which roles show presence in the room. 

List Room in 
Directory  

Leave checked for the chat room to appear in room search 
results.   

Room is Persistent Leave checked for the chat room to remain on the server after 
all occupants exit the room. Uncheck for the room to be 
removed from the server after all occupants exit the room.   

Room is Moderated  Leave checked to set moderation options. 

Room is Members-
only 

Enable to restrict rooms to members only. (Select Room 
Permissions icon in Group Chat room to set memberships). 

Allow Occupants to 
Invite Others  

Enable to allow room occupants to invite other users to 
participate in the room. 

Password Required 
to Enter Room 

Password-protect room so that users must enter the supplied 
password in order to join.   

Password  Password users must enter in order to join room, if password-
protected.  

Role that May 
Discover Real JIDs 
of Occupants 

The default, “Anyone” option, allows all users to see another 
user’s JID when they hover their cursor over a name in the 
Participants list. To restrict this function to only the Moderator, 
first assign one or more users as Moderator, then select 
“Moderator”  from this drop-down list.  

Only login with 
registered nickname 

When enabled, only registered nicknames will display in 
Participants list. 
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Allow Occupants to 
change nicknames 

Leave checked to allow room occupants to change their 
nicknames in the room. 

Allow Users to 
Register with the 
room 

Leave checked to allow users to request membership if this 
room is defined as a member’s only room. 

Room Admins Add or remove a user’s administrator permission for the room.  

Room Owners Add or remove a user’s owner permission for the room. 

 

4.9.2.4 Group Chat Room Permissions 

In rooms that you create, you may want to manage the permissions of room 
participants. You (and any other users designated as “owner”) can assign permissions 
to other users by placing them in one of the available rolesTable 8 Group Chat Room 
Permissions describes the available roles. 
 

1. From the Group Chat room, click the “Room Permissions” icon in the upper right 
corner. 

2. The Room Permissions window appears, with a list of users from My Contacts 
on the left and tabs for each permissions level on the right. 

3. To see who is in each permissions level, click on the level’s tab. 
4. To assign permissions to a user, first click on the level’s tab to open its roster 

in the right column. Then, highlight the user’s name and use the right arrow 
button () to move the user into that level. 

5. To remove permissions from a user, click on the level’s tab to open its roster in 
the right column. Highlight the user’s name in the roster and use the left arrow 
button () to move the user back to the main list. (Note: Once a user is added 
to the “owner” role, he cannot be removed from that role.) 

6. Add Other may be used to manually grant permissions to someone not 
appearing in the ‘All Users’ list. 

7. Search may be used to conduct a user search to grant permissions. 
 

In the Participants list of the Group Chat room, a letter displays in parentheses after 
each user’s name. This letter indicates the user’s permissions in the room. See Table 8 
Group Chat Room Permissions 
 

Table 8 Group Chat Room Permissions 
 

Permission Description Role 
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Admin Admins can assign permissions, but cannot configure the room. Moderator (M) 

Member Room members can participate in room chat. If the room is 
configured for members-only access, only users with the admin, 
member, or owner role will have permission to access the room. 
  

Participant (P) 

None Users with “none” permissions can view the messages in the 
room but cannot send messages in the room If the room is 
members-only access, users with “none” permissions will not 
have permission to access the room.   

Visitor (V) 

Outcast Outcasts will not be allowed at all into the room. If a user is 
assigned outcast permissions while participating in the room, he 
will be removed from the room and will receive notification that a 
moderator removed him from the room.   

None 

Owner Rooms can have multiple owners. Owners can assign users to 
member, none, or outcast roles. Only an owner can assign 
additional owners. Based on the XMPP server, owners may or 
may not be able to remove themselves or others from the 
owner role. 

Moderator (M) 

 

4.9.2.5   Invite Users to a Room 

Follow these steps to invite a user to a chat room: 
 
1. From the Group Chat room, click the “Invite Users” icon. The Invite window appears. 
2. To invite a single user click Add JID. 

a. Select the JID from the drop-down menu and click OK. 
b. The Add Recipient JID window closes and the invitee is added to the 

invitation recipient list. 
3. To invite multiple users, click Add JIDs. 

a. Select the JIDs from the All Users list and move them to the Invitees list using 
the left and right arrows. To select multiple JIDs, hold down the Ctrl key while 
making selections. 

b. Click Apply to close the window and add the invitees to the invitation recipients 
list. Click 
Cancel to close the window without saving the selections. 

4. Review the Recipients list. The JID(s) you selected will appear in this field. 
a. If you wish to add more JIDs to the invitation, repeat step 2 or 3. 
b. If you wish to remove any JIDs from the invitation, highlight the JID(s) and click 

Remove. 
5. If desired, change the Subject field by placing your cursor in the field and 

deleting or adding text as needed. 
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6. If desired, change the invitation message field by placing your cursor in the field 

and deleting or adding text as needed. 
7. Click Send when you are ready to send the invitation. 

 

4.9.2.6   Send a Message 

Type the message in the bottom portion of the window. Use the up and down arrow 
keys to recall previous entries. 
 

 
Figure 133 Enter and Send Message in Chat 

4.9.2.7   Search for Text in Group Chat Window 

Just like with one-to-one chat, TransVerse provides a “Find” feature to search within the 
active Group Chat window for keywords. 
 
1. In Group Chat, select the “Find” icon. 
2. The Find toolbar appears at the bottom of the Group Chat window. 
3. Enter text in the “Find” field and hit the Enter key. 

a. Use Highlight All to highlight all instances of the specified keyword. 
b. Use the Next and Previous arrows to move from one instance of the keyword 

to the next. The current instance will be highlighted in green. 
c. Check “Match case” to search for the keyword exactly as you have entered it. 

4. To close the Find toolbar, click the red X in the lower left corner of the toolbar. 
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Figure 134 Search in Group Chat 

 

4.9.3 My Contacts 

My Contacts is a list of all the XMPP users a TransVerse user selects as contacts. To 
become contacts, users must subscribe to one another’s presence status. Note that 
only same-side users can be added as contacts. The My Contacts panel provides 
access to the following functionalities:  

• Place contacts in named Groups. A contact may appear in more than one group.  
• Send a message to a group of contacts.  
• View the presence (status) of contacts.  
• Send a message to a contact.  
• Start an individual chat with a contact.  
• Send a file to a contact.  

This section provides instructions for the following:  

• Add a Contact  
• Right-click Options in My Contacts  
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Figure 135 My Contacts 

4.9.3.1   My Contact Action Panel Tool Bar Icons 

Table 9 My Contacts Action Panel Tool Bar Icons 
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4.9.3.2   Adding a Contact 

 
Figure 136 Add Contact Dialog 

 
There are multiple methods to add a contact to My Contacts. Through the “Add 
Contact” icon: 
 

1. From the My Contacts Action Panel Tool Bar, click on the “Add Contact” icon. 
2. Input the user’s JID. The JID format is username@servername (e.g., 

chatuser@xmpp.je.jfcom.mil). 
3. Give the user a nickname, which will be how the user’s name appears in your My 

Contacts list. 
4. Type the name of a new group or add the new contact to an existing group. 
5. Click OK. 
6. A subscription request will be sent to the new contact. Once the contact accepts 

the subscription, his presence status will display in your My Contacts list. Until 
the contact accepts the subscription, his presence status will display “Offline” 
with a grey question mark icon. 

 
Through User Search: 
 

1. From the My Contacts Action Panel Tool Bar, click the “User Search” icon. 
2. Select a Search Service (default server should be highlighted. To add another 

search service, click Add and enter name of the service.). 
3. Input name, email, or username of the user you wish to find and click Search. 
4. To add a user to My Contacts, right-click on the username from the Search 

Results and select “Add Contact.” 
5. The Add Contact Dialog will appear. Make any desired changes to the username 

and click OK. 
6. A subscription request will be sent to the new contact. Once the contact 

accepts the subscription, his presence status will display in My Contacts. 
Until the contact accepts the subscription, his presence status will display 
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“Offline” with a grey question mark icon. 

7. To exit the User Search, click the “X” in the upper right corner of the pane. 
 

 
Figure 137 User Search 

 
 

4.9.3.3   Right-Click Options in My Contacts 

You can right-click a single contact’s name from My Contacts or select multiple contacts 
(using Ctrl key) for additional functions.Table 10 lists the right-click options available 
when a single user is selected and Table 11 lists the right-click options available when 
multiple users are selected. 
 

Table 10 My Contacts Right-Click Options for Single Selection 
 
Chat Opens chat with the selected contact. 
Send Message Opens the Compose window with the selected contact’s JID 

in the “To” field. 
Invite To This option is available if you are in Group Chat, and it 

allows you to invite another user to the room. Opens the 
Invite window with the selected contact’s JID in the “To” 
field.  

Group Chat Creates a new Group Chat room and opens the Invite 
window with the selected contact’s JID in the “To” field.  
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Send File Opens the Send File dialog window to browse and select file 

to send to selected contact.   
View Chat Log Opens the Chat Log Action Panel to display the history of 

your chat sessions with the selected contact.   
Copy To Allows you to copy the selected contact to another existing 

group, or to create a new group and copy the contact.  
(Note: Placing your contacts in groups is useful if you wish to 
Message entire groups of contacts.)   

Move To Allows you to move the selected contact to another existing 
group, or to create a new group and move the contact.  
(Note: Placing your contacts in groups is useful if you wish to 
Message entire groups of contacts.)   

Assign Color Opens the Color Management window, where you can 
designate a color for chat messages from the selected 
contact. Assigning colors to contacts can make it easier to 
find their messages during Group Chat.   

Delete Contact Allows you to delete the selected contact from My Contacts.  
(Note: Deleting a contact will remove the contact’s name 
from your list and will also remove your name from their 
contact list.)   

Change Contact Opens the Change contact window, where you can change 
the nickname or group for the selected contact.   

Subscribe to Presence Since users can be added to your contacts roster without 
your being subscribed to their presence, this option is 
available when you wish to subscribe to their presence.   

Presence for this Contact Allows you to select a presence status visible only to the 
selected contact. For instance, if your overall presence is 
“Away,” but you wish to remain available for the selected 
contact, use this option to select “Online.” 

 
 

Table 11 My Contacts Right-Click Options for Multiple Selection 
 
Send Message Opens the Compose window with the selected contacts’ JIDs in the “To” 

field. 

Invite To This option is available if you are in Group Chat and allows you to invite 
selected users to the room. Opens the Invite window with the selected 
contacts’ JIDs in the “To” field. 

Group Chat Creates a new Group Chat room and opens the Invite window with the 
selected contacts’ JIDs in the “To” field. 

 

4.9.4 My Places 

My Places (Figure 138) displays a listing of the rooms available for Group Chat. 
Within My Places, there are three main folders: My Server, Hyper-Rooms, and 
Favorites. 

 
• The My Server folder displays all the chat rooms accessible on your local (Default) 
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server. 

• The Favorites folder allows you to bookmark favorite rooms. 
• Hyper-Rooms allow you to create a customized view by combining multiple 

group chat rooms into a single view within the hyper-room. 
 
Depending on your system’s setup, you may be able to add additional servers to My 
Places and view the list of chat rooms on those servers. A server defined in My Places 
automatically discovers all conference services available on the server. 
 

 
Figure 138 My Places 

 

4.9.4.1 My Places Action Panel Tool Bar Icons 

Table 12 My Places Action Panel Tool Bar Icons 
 

 

Undock 
Window 

Undocks the Action Panel. This icon is only available on docked windows. 

 

Dock Window Docks the Action Panel. This icon is only available on undocked windows. 

 

Add Server Opens an input window to enter a server name. My Places, My Server, or 
an additional server must be selected for this icon to be available. 

 

Find Rooms Opens an input window to enter a conference server to query for available 
rooms. This button allows the user to find all group chat rooms listed in 
the server directory.  Any folder except Hyper-Rooms must be selected for 
this icon to be available. 
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Add Room Allows user to add a room to the selected folder (if the server 
configuration allows users to add rooms). Any folder except My Places 
must be selected for this icon to be available. 

 

Add to 
Favorites 

Adds selected room to Favorites. 

 

Enter Room Opens the selected room and displays user’s presence in the room. This 
icon is only available if a room is selected. 

 

 

Edit Room Opens the Edit Room Parameters window that allows user to change the 
room name and address, and enter a description and Point of Contact for 
the copied room. This icon is only available after a room has been copied 
to Favorites. 

 

 

Assign Color Opens a palette window to assign a color to the selected room. This icon is 
only available if a room is selected. 

 

 

Refresh Server Queries the servers for updates. 

 

 

Cut Deletes selection. 

 

 

Copy Copies the selected room to the clipboard. After selection is copied, the 
icon changes to Paste icon. 

 

 

Paste Pastes last entry from the clipboard. 

 

 

Add Folder Allows user to add subfolders to the Favorites folder. This icon is only 
available if Favorites is selected. 

 

 

Rename Allows user to rename a folder in Favorites or a Hyper-Room. This icon is 
only available once a new folder is created. 

 

4.9.4.2   Enter Group Chat through My Places 

1. Select a Group Chat room from those listed under My Server (Figure 138) or 
another available server. 

2. To enter the Group Chat room, there are three options: 
a. Double-click on a room. 
b. Right-click and select “Enter Room.” 
c. Select the room and select the “Enter Room” icon. 

 

4.9.4.3   Refresh a Server 

The refresh function (Figure 139) updates the list of rooms for a conference server. 
 
1. In My Places, select the server folder to refresh. 
2. Right-click and select “Refresh Server,” or click on the “Refresh Server” icon. 
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Figure 139 Refresh a Server 

4.9.4.4 Finding a Room 

The “Find Rooms” feature in My Places (Figure 140) can generate a list of rooms listed 
in the directory on the default server or on a different server. From this list, you can 
enter a room, Assign a Color to the room (to designate the room in a Hyper-Room), or 
simply view the address for each room. 
 
Just as TransVerse users are identified by JIDs, chat rooms in TransVerse each have a 
JID. A room’s JID uses the format of roomname@conference.servername (e.g., 
roomone@conference.chat.apps.mil). 
 
 

 
Figure 140 Find a Room 

4.9.4.5   Finding a Room on the Default Server 

1. From the My Places action panel tool bar (Figure 141), click the “Find Rooms” icon. 
2. The Input dialog appears, displaying the default conference server. 
3. Enter the name of the server to search. Typically, most XMPP conference 

servers are prefixed with “conference” (for example, the JID bob@acme.com 
likely corresponds to the conference server conference.acme.com.). 

4. Click OK. TransVerse will connect to the server with the request and, if 
the user has permissions to access rooms on that server, will return a 
list of rooms. 
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5. To enter a room, double-click on its name. You can also highlight a room and 

right-click and select “Enter Room.” 
6. To Assign a Color to a room, highlight a room and click Assign Color or right-

click and select “Assign Color.” See 4.12.1.3 for details. 
7. Click Close to exit the Room Query list. 

 

 
Figure 141 Finding a Room on Default Server 

 

4.9.4.6   Add a Room in Favorites 

1. Select the Favorites folder in My Places. 
2. Right-click and select “Add Favorite” (Figure 142) or click on the “Add Favorite” icon. 
3. The Edit Room Parameters window appears. You can either add a current 

room, if you know the Room Name and Address, or create a new room. Enter 
the following information: 
a. Room Name (default is New Room). 
b. Room Address (default is provided - change prefix to match the room name). 

Note that the Room Address is the same as the Room’s JID. Once a Room 
JID/Address is assigned, it will remain the same despite any changes to the 
Room Name. 

c. Room description (optional). If desired, enter text to indicate topic of room. 
d. Point of contact (optional). 

4. Click OK. 
5. The room is created and added to the Favorites folder. 
6. Double-click on the room to enter it. 
7. You will be prompted to configure the new room. Click yes to configure the 
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room. (If you do not configure the room, other users may not have access to it.) 

 

 
Figure 142  Add a Room in Favorites 

4.9.4.7   Add a Room on My Server 

1. Select the My Server folder in My Places. 
2. Right-click and select “Add Room” or click on the “Add Room” icon. 

 

 
Figure 143 Add Room Dialog 

 
3. Enter the Room Name (Figure 143). The default is NewRoom. Any spaces entered 

in a room name will be converted to underscores when the room is listed in My 
Places and capital letters will display as lowercase (e.g., “New Room” will display 
as “new_room” in My Places). Note that the room name you enter will serve as the 
first part of the room’s JID (e.g., the JID for the room named NewRoom will be 
newroom@servername.). 
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4. Click OK. 
5. You will be prompted to configure the new room. Click Yes to configure the room. 

(If you do not configure the room, other users may not have access to it.) 
6. If you are unable to see the room on the server, the configuration may not be 

such to allow users to add rooms on the server. 

4.9.5 Favorites 

Within Favorites, you can drag and drop rooms and folders to reorganize. You can also 
drag and drop rooms from My Server into one of the folders in Favorites. 

4.9.5.1   Add a Folder to Favorites 

You may want to add folders to Favorites in order to group selected room shortcuts. 
 
1. In My Places, select the Favorites folder. 
2. Right-click and select “Add Folder,” or click on the “Add Folder” icon. 
3. In the input dialog box, enter the new folder name and click OK to save. 
4. The new folder is added under Favorites. Shortcuts in Favorites can be dragged 

and dropped into this folder. 
 

4.9.5.2   Copy and Paste a Room to Favorites 

Room shortcuts can be added to Favorites, using the Copy/Paste features. 
 
1. In My Places, highlight an existing room not already located in Favorites. 
2. Right-click and select “Copy,” or click the “Copy” icon. 
3. Select the Favorites folder or a folder created within Favorites. Right-click and 

paste the room, or click on the “Paste” icon. 
4. The room link is pasted into the folder. 

4.9.6 Messages 

The Messages Action Panel (Figure 144) allows email-type messages to be sent to 
other users or groups of users. A message is a way to communicate with another user 
without entering a chat session. The message recipient does not need to be online. 
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Figure 144 Messages Action Panel (docked) 

 

 
Figure 145 Messages Action Panel (undocked) 

 

4.9.6.1   Messages Action Panel Tool Bar Icons 

Table 13 Messages Action Panel tool Bar Icons 
 

 

 
Undock 
Windo

 

Undocks the Action Panel. This icon is only available on docked windows. 
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Dock Window Docks the Action Panel. This icon is only available on undocked windows. 

 

 
New Message Opens a new Compose display area. 

 

 
Reply Opens Compose display area with the recipient name, subject, and text from 

  original message filled in. This icon is only available if there is a Message selected.   
 

 
Delete 
Message 

Deletes the selected message. This icon is only available if there is a Message 
selected. 

 

4.9.6.2   Send a Message 

1. Open the Compose window by following the instructions in 4.9.6.6 Open the 
Compose Window. 

2. If necessary, add a JID to the message (Figure 146): 
a. Click on Add JID.  The Add recipient JID window will appear. Select a JID 

from the drop- down menu or manually type one in by highlighting the visible 
JID and then typing. 

 

 
Figure 146 Add recipient JID window 

 
b. If sending the message to more than one contact, repeat Step a until all JIDs are 

added. 
c. To remove a JID from the Recipients field, select the JID from the list and 

click Remove. You can select multiple JIDs at one time by holding down 
Ctrl as you select the JIDs from the list. 

3. Type a subject in the “Subject” field. 
4. Type a message in the white text area below the “Subject” field. 
5. Click Send. 

 

4.9.6.3   Reply to a Message 

You can reply to the sender of a message using the following steps: 
 
1. Select a received message from your Messages Action Panel. 
2. Click the “Reply” icon. 
3. The Compose window will appear, with the original sender’s JID appearing in the 
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“Recipients” field and the original message in the white text area. 

4. Type your reply message in the white text area. 
5. Click Send. 

 
Note: These steps assume that the recipient does NOT have “Force Messages to Chat” 
enabled in Preferences. If “Force Messages to Chat” is enabled, you can reply to the 
sender of a message by replying within the chat window. 

4.9.6.4   View Received Messages 

Messages you receive in a single TransVerse session remain in your Messages inbox 
until you exit TransVerse. You can disconnect/reconnect and still see the messages in 
the inbox. 
 
To view received messages from a previous session of TransVerse, access the Chat 
Logs Action Panel and select log by the sender’s JID. 
 

4.9.6.5   View Sent Messages 

The Messages Action Panel does not currently display your sent messages. You can 
easily view the text from sent messages by accessing the Chat Logs Action Panel and 
select log by the recipient’s JID. 

4.9.6.6   Open the Compose Window 

To send new messages you must access the Compose window. You may access the 
Compose window from the My Contacts Action Panel.  There are multiple ways to 
access the Compose window: 
 
1. Right-click on one or more contacts and select “Send Message.” 
2. The Compose window appears with the selected users’ JIDs in the 

“Recipients” field of the message. 
 

 

4.10 Chat Logs 

TransVerse Chat Logs contains the logs of all prior Chat and Group Chat sessions 
and messages received and sent on the local client. If you use TransVerse on more 
than one computer, each client will contain the logs for that local machine only. 
 
Chat log files are rolled over daily. The storage location for the chat log files can be 
defaulted to the log directory that exists in USER_HOME_DIRECTORY\.transVerse 
directory. This default directory is named logs-“username”@”servername” per the 

  
DCS_User_Guide_20150126 128  

UNCLASSIFIED // FOUO 
 



DCS User Guide 
March 6, 2015 

 
account used. Alternatively, the log directory can be configured. Within the log 
directory, a directory exists for each chat room and one-to-one chat ever participated 
in. A date base named log file is created in this directory for each day chat is active. 
 
To access this functionality, select View—Chat Logs through the Top-Level Menu Bar, 
or click the Chat Logs action panel (Figure 147). 
 

 
Figure 147 View Chat Logs 

 

4.10.1.1 Chat Log Action Panel Tool Bar Icons 

 
Table 14 Chat Log Action Panel Tool Bar Icons 

 
 

 
Undock 
Windo

 

Undocks the Action Panel. This icon is only available on docked windows. 

 

 
Dock Window Docks the Action Panel. This icon is only available on undocked windows. 

 

 
Refresh Chat 

  Logs List   
Updates the Chat Logs display area with the current chat logs. 

 

 
Delete Chat 

  Log   
Deletes the selected Chat Log. This icon is only available if a chat log is selected. 

 

 
Back Available when viewing a Chat Log or Search results. Returns you to the previous 

screen. 

 

4.10.1.2 Search Chat Logs 

Chat Logs offers a search feature for searching all Chat Logs. 
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1. Enter the text to be searched for in the Search box. 
2. Click Go. 
3. Results are displayed. 
4. Double-click a selected result to view details of that one-to-one or group chat 

session, or click View with the selection highlighted. Results may be reordered 
based on Date, Classification, From, To, and Chat columns by clicking the 
column title. 

 
Note: Searching again after results are displayed will search within those results. 
 
TransVerse’s Chat Logs search function maintains an index of significant words 
appearing in chat sessions and messages. Significant words are those besides 
common words such as the, that, and, an, and so on. If Re-Index is selected, 
TransVerse’s index is cleared and recreated based on a new scan of all available 
sessions and messages. Since the re-index process can become lengthy, it is 
recommended that you only select Re-Index if advised by your system administrator. 
 

4.11  Hyper-Rooms 

Hyper-Rooms (Figure 148) are virtual rooms you can customize for yourself to 
participate in multiple chat sessions concurrently in the same window. If you are 
monitoring several Group Chat sessions at once, combining these in a Hyper-Room 
provides a simpler view of the message traffic. Hyper- Rooms can be useful in both real 
world and exercise conditions. For example, if you are an analyst during an exercise, 
you may wish to monitor multiple rooms simultaneously to see the effects of an injected 
scenario. 
 
The creation and modification of Hyper-Rooms is much like the process used under 
Favorites for folders. You can copy and paste rooms from My Server or other servers 
into a Hyper-Room. 
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Figure 148 Hyper Room 

 

4.11.1 Add a Hyper-Room 

1. In My Places, select the Hyper-Rooms folder. 
2. Right-click and select “Add Hyper-Room” or click on the “Add Hyper-Room” icon. 
3. Enter the Hyper-Room name in the input box and click OK. (Default is “New Hyper 

Room.”) 
4. Verify the new room name is displayed under the Hyper-Rooms folder. 

 

4.11.2 Add Room(s) to the Hyper-Room 

You can drag and drop an existing room from My Server into a Hyper-Room or you can 
do the following: 
 
1. In the Hyper-Rooms Folder, select a Hyper-Room. 
2. Right-click and select “Add Room,” or click on the “Add Room” icon. 
3. The Edit Room Parameters window appears. 
4. Enter the following information: 

a. Room Name 
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b. Room Address 
c. Room description (optional) 
d. Point of contact (optional) 

5. Click OK. 
6. Verify that the room link appears in the Hyper-Room. 
7. Repeat steps 1-5 to add other rooms to the Hyper-Room. 

 

4.11.3 Enter a Hyper-Room 

1. In the My Places Action Panel, select an existing Hyper-Room. 
2. There are three different ways to enter the Hyper-Room: 

a. Right-click and select “Enter Room” 
b. Click on the “Enter Room” icon 
c. Double-click on the Hyper-Room 

 

4.11.4 Send a Chat Message in a Hyper-Room 

Chatting in a Hyper-Room (Figure 149 is very much like chatting in a regular Group 
Chat room, except that you will see messages from multiple chat rooms at the same 
time. To send chat messages, you need to specify in which chat room or rooms your 
message should appear. Follow the steps below to send a chat message in a Hyper-
Room. 
 
1. Type your message in the white text area. 
2. Click the To button above the text area. 
3. A small window appears listing the chat rooms in the Hyper-Room. A 

checkmark appears beside each room to which the message will send. Click a 
room name to select or deselect it. 

4. Click Close when finished selecting rooms. Note: These settings will remain until 
you change them. 

5. Click Send or press Enter to send message to the selected rooms. 
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Figure 149 Chat in a Hyper-Room 

4.12 Color Management 

4.12.1.1 Setting Foreground and Background Colors 

You can set the foreground and background colors (Figure 150) for TransVerse to suit 
individual needs. These colors may be set via the TransVerse Text Monitoring and 
Keyword Highlighting window. 
 
To set the background and foreground colors: 
 
1. From the Top-Level Menu Bar, select Edit—Colors. 
2. The TransVerse Text Monitoring and Keyword Highlighting window is displayed. 
3. Select the Settings tab. 
4. Click Default Background Color to set the background color or click Default 

Foreground Color to set the foreground color. 
5. A color selection dialog is displayed. 
6. Select the desired color. The dialog has a preview of how the foreground/background 

combination will look. 
7. Click OK to accept the color selected and close the color selection dialog. 
8. Click Save on the TransVerse Text Monitoring and Keyword Highlighting window and 

the selected color will be immediately applied to TransVerse. 
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Figure 150 Setting Foreground/Background Colors 

 

4.12.1.2 Assign Color to a Contact 

You can assign colors to contacts (Figure 151) to easily differentiate between chat 
messages during a group chat session or an individual chat session. The user’s name 
will appear in chat sessions with the selected color. If there is no matching keyword in 
the display message, the entire message will be displayed in the user’s color. Use the 
steps below to assign a color to a user. 
 
1. Right-click on the user’s name from My Contacts or the Participants list (if in a 

group chat). Alternatively, you can select Edit—Colors from the Top-Level Menu. 
2. The TransVerse Text Monitoring and Keyword Highlighting window will open. 
3. The user’s name will appear in the User Colors tab with the default color. 
4. You can manually add a user’s name to the list by entering it in the “User 

Name” field and clicking Add. The “*” wildcard character may be used to 
create patterns to match. 

5. Select a color for the user. 
a. To select from the Swatches tab, just click on the color. 
b. To set color using Hue, Saturation, and Brightness (HSB) values, click on the 

HSB tab and do one of the following: 
c. Slide the vertical HSB selector until the desired color appears. 
d. Use the up and down arrows beside the H, S, and B values. 
e. To set color using Red, Green, and Blue (RGB) values, click on the RGB tab 

and slide the horizontal bars to select the desired R, G, and B values. 
6. If desired, you can select the setting to “Match Whole Words Only” or “Case 

Sensitive.” 
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7. Click Apply. 
8. Repeat steps 3-7 to assign colors to additional contacts. 
9. Click Save to accept color assignment for the contacts. 

 

 
Figure 151 Setting Contact Color 

 

4.12.1.3 Assign Color to a Room 

You can assign colors to chat rooms (Figure 152) to easily differentiate between the 
rooms grouped in a Hyper- Room. If a message is received in a room and does not 
have a matching contact/user, the assigned room color will be used. 
 
1. Right-click on the room’s name from My Places or from the list of a “Find 

Rooms” search. Alternatively, you can select Edit—Colors from the Top-Level 
Menu. 

2. The TransVerse Text Monitoring and Keyword Highlighting window will open. 
3. The room name will appear in the User Colors tab with the default color. 
4. Select a color for the room. 

a. To select from the Swatches tab, just click on the color. 
b. To set color using HSB values, click on the HSB tab and do one of the following: 
c. Slide the vertical HSB selector until the desired color appears. 
d. Use the up and down arrows beside the H, S, and B values. 
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Figure 152 Setting Room Color 

 

4.12.1.4 Keyword Highlighting and Alerts 

1. From the Top-Level Menu Bar, select Edit—Colors. 
2. The Text Monitoring and Keyword Highlighting dialog is displayed (Figure 153). 
3. The Settings tab provides the ability to control where keyword highlighting and 

alerting will be used. The following settings are available from this tab: 
a. “Highlight in Chats” enables/disables keyword highlighting in one-to-

one chats. Highlighting is based on settings on the “Keywords” tab. 
b. “Highlight in Group Chats” enables/disables keyword highlighting in 

group chats. Highlighting is based on settings on the “Keywords” tab. 
c. “Alert in Chats” enables/disables the playing of sounds associated with 

keyword matches in one-to-one chats. 
d. “Alert in Group Chats” enables/disables the playing of sounds associated 

with keyword matches in group chats. 
4. The Keywords tab allows for the creation of keywords to search for in chat 

sessions. The following steps create a keyword: 
a. Type the desired text in the keyword field and click Add. The “*” wildcard 

character is allowed. 
b. Highlight the newly added keyword in the keyword list. You can select multiple 

words f r o m  the keyword list (using the Ctrl key) to apply settings to all of the 
selected keywords at the same time. 

c. Use the “Match” pull down to control what to match: just the message text, just 
user names, or either. 

d. The “Match Whole Words Only” setting enables/disables matching on whole 
words only. 
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e. The “Case Sensitive” setting enables/disables matching on exact case. 
f. A sound may be associated with a keyword. To associate a sound with a 

keyword, click Sound. A file selection dialog is displayed allowing the 
selection of “.wav”, “.au”, and “.aiff” file types. Select the desired file and click 
Open. The file name is displayed in the sound text field and the sound 
checkbox is selected. The playing of sound is controlled by the “Alert in 
Chats” and “Alert in Group Chats” settings on the Settings tab. 

g. Select the desired color for the keyword from the color selection panel. The 
selected color is displayed below the “Sound” field. 

h. Click Apply. NOTE: THE APPLY BUTTON MUST BE PRESSED FOR 
KEYWORD SETTINGS TO BE APPLIED. 

i. Matching of keywords is hierarchical – top to bottom. Keywords may be 
moved up and down via the Up and Down buttons on the bottom of the 
Keywords tab. Only the settings of the first keyword to match a message will 
be applied to the matched message. The entire text of the message will be 
highlighted in the keyword color and the keyword sound (if the keyword has 
one) will be played according to whether or not the “Alert in” setting is 
enabled. If there is not a matching user color, the user name is also displayed 
in the keyword’s color. 

 

 
Figure 153 Keyword Highlighting Settings 

 
5. The Places tab controls the alerting in chat rooms you do not explicitly enter. You 

can control which rooms are monitored by using the following steps: 
a. To add rooms that are not already listed in the Places section: 

i. Click Add Other. 
ii. The Enter Room Parameters window will appear (Figure 154). 

iii. Enter the Room Name and Room Address. 
iv. Click OK to make the room available. 
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Figure 154 Add Monitored Room 

 
b. To set a room to be monitored, highlight a room in the Places section and add it 

to the 
Places to Monitor section by clicking the right arrow. 

c. To delete a room from the Places to Monitor list, highlight it in the list and 
use the left arrow to remove it. 

 

4.13   Disconnect and Exit 

4.13.1 Leave a Room or Chat Session 

To leave a room or Chat session, click on the “X” icon in the upper right-hand corner of 
the session (or Action Panel) you wish to close. 

4.13.2 Disconnect from the Server 

To disconnect from the server, click the red “Disconnect” icon on the Main Tool Bar or 
select TransVerse—Disconnect from the Top-Level Menu Bar. Disconnecting from the 
server will change your presence to “Offline.” 

4.13.3 Exit TransVerse 

To exit TransVerse, select TransVerse—Exit from the Top-Level Menu Bar. Exiting 
TransVerse will change your presence to “Offline.” 
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Appendix A - Glossary of Terms, Acronyms, and Definitions 
Table 15 - Glossary of Terms, Acronyms, and Definitions 

Term Acronym Definition 

   

Administrator  The Administrator has the highest level of permission over the web 
reservation.  All Administrators have equivalent permissions with no 
one maintaining higher preference.   In a web meeting the 
Administrator enters a Moderator.  (Note: if no user has Administrator 
permissions there is no way to delete the reservation and this cannot 
be performed by the Service Desk or Tiered support administrators).  
The administrator maintains and controls the overall operation of the 
web reservation through the extra “Admin” tab within the reservation 
space. 

Moderator  The Moderator permission level differs from the Admin in the 
Reservation only.  The inclusion of the user to the reservation will place 
a reservation placeholder with the Moderator’s home page allowing for 
the ability to reference the meeting at a later time.  The moderator 
within a web meeting maintains control over all aspects of the meeting.  
A web meeting moderator may be either a reservation Admin or 
Moderator.  All Moderators maintain the same capabilities and must 
coordinate actions to ensure they do not interfere with one another. 

Presenter 

 

 The Presenter permission is only available within the meeting.  The 
Presenter permission cannot be granted within the Reservation space.  
The permission persists only for the current meeting.  If the meeting is 
restarted a Moderator or Admin must re-assign the permission to the 
User.  There is only one Presenter at any given time within a meeting.  
The Presenter may control and navigate the Presentation panel 
through the use of extra controls only viewable to the presenter.  The 
Presenter may upload and display files along with share a view of their 
screen. 

User  Users maintain no extra permissions afforded to the Admin, Moderator, 
or Presenter.  The benefit of entering as an authenticated user is it 
allows the Admin or Moderator the ability to verify the Users identity.  
The User permission level is able to participate in the Chat panel, in 
both public and private chat.  The User may download screen shots of 
the Presentation panel for reference.  The User permission level is 
allowed to “Raise a hand” in the User panel, however most other 
features are limited and not available for use. 

Guest User  Guest Users are those that are unable to authenticate as verified 
Users.  Access to meetings is based upon the validation of a 
Moderator or Admin upon request for entrance.  Guest Users are able 
to enter and participate at the same level as a User in a meeting.  
Guest Users are not able to create or use Reservations.  Guest Users 
are able to be granted the permission of Presenter in a meeting. 
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Term Acronym Definition 

DCS Information 
Portal 

 The DCS Information Portal page contains the information needed to 
understand and operate the DCS service on NIPR/SIPR with the ability 
to selectively submit feedback to the program through interaction with 
the product service desk.  Announcements posted by the DCS PMO 
regarding system availability will be posted along with training events 
and pertinent information regarding any future events for the DCS 
service.  Please refer to section 2.1 for further detailed information. 
 

DCS Reservation  Reservations are the visual placeholders that provide information 
regarding Meetings.  All meetings will require that the user creates a 
Reservation.  Within the reservation pages Users are able to find tabs 
and links allowing the User to grant permission levels to participants, 
copy and provide the URL that will direct users/guests to the Meeting, 
start/stop Meetings, identify if the Meeting is to be recorded, and 
include how many participating users are anticipated for the Meeting 
(max 250).   

 

DCS Meeting  The DCS Meeting window comprises up to 4 different panels: Display, 
Chat, Web Cam, and User.  Within the DCS Meeting window the user 
will be able to interact with the presentation and other users at various 
permission levels.  The Meeting is where a user with proper 
permissions may be able to upload documents for use in presenting 
and whiteboard use.  Audio and web cam integration is supported and 
can allow the user to interact with others at Moderator, Presenter, 
User, and Guest permission levels.   

DCS Home Page  The DCS Home Page provides the user a platform for reservation 
creation after being authenticated through the use of their CAC or other 
PIV signature hard token if user is maintains dual persona accounts.  
Users will be able to create and administer reservations and invitations 
to scheduled Meetings.  Users will be able to access their recorded 
Meetings however will not be able to load or store files for use in 
Meetings.  Please refer to section 2.2 for further detailed information. 

Extensible 
Messaging and 
Presence 
Protocol 

XMPP Extensible Messaging and Presence Protocol (XMPP) is 
a communications protocol for message-oriented middleware based 
on XML (Extensible Markup Language).[1] The protocol was originally 
named Jabber,[2] and was developed by the Jabber open-source 
community in 1999 for near real-time, instant 
messaging (IM), presence information, and contact list maintenance. 
Designed to be extensible, the protocol has also been used for publish-
subscribe systems, signaling for VoIP, video, file transfer, 
gaming, Internet of Things (IoT) applications such as the smart grid, 
and social networking services. 
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Term Acronym Definition 

Defense 
Information 
Systems Agency 

DISA DISA is a United States Department of Defense agency that provides 
information technology (IT) and communications support to the 
President, the Vice President, the Secretary of Defense, the military 
Services, and the Combatant Commands. http://www.disa.mil/ 

Department of 
Defense 

DoD DoD, (also known as the Defense Department, USDoD, DoD, DoD, or 
the Pentagon) is the Executive Department of the Government of the 
United States of America charged with coordinating and supervising all 
agencies and functions of the government concerned directly with 
national security and the United States armed forces. 
http://www.defense.gov/ 

   

Defense 
Collaboration 
Services  

DCS The Defense Collaboration Services are the follow on capabilities for 
the current DoD collaboration service. 
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